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About this manual 

Questions about this manual 
Before you start reading you might have questions concerning this document. In 
this section, we answer some of those questions.   

Who is part of the target group? 
This manual is intended for persons working with the Configuration module or 
wanting to learn about its individual features. It makes no difference whether 
you are using this document in printed or online form.  

Use this manual as you see fit, for reference purposes or to get to know the 
options the Configuration module provides.  

Please note that as a user you might have different authorizations (privileges). To 
be able to use all functions of the Configuration module, you either need to 
have the respective privileges or sign on as a specific user with the respective 
password.  

What kind of information is provided? 
This document contains information on how to use and operate the 
Configuration module.  
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What kind of information is not provided? 
This document does not provide information on the installation and 
commissioning of the Configuration module. You can find information about 
other modules in the IP Office Contact Center system in the corresponding 
documents.  

How is this manual organized? 
The structure of this document provides a systematic introduction to the use of 
the Configuration module. Once you have read a few pages you will notice that 
topics are structured similarly. Usually, an introduction to the topic is provided 
first. Prerequisites or necessary skills are often described next, Instructions 
follow the prerequisites or necessary skills. An illustration or example further 
clarifies the topic.  

Which edition are you reading? 
The following table lists information about this edition:  

Compiled on: February 25, 2014 

Based on: Configuration module 
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Getting to know the 
Configuration module 

What is Configuration? 
The Configuration module is a central module of a IP Office Contact Center 
system for configuring objects. The other modules use these configured objects.  

Get to know the most important terms used with the Configuration module.  

What can you configure? 
You configure all objects of a IP Office Contact Center system with the 
Configuration module. You also configure system settings. You can change 
configurations and delete objects.  

What does configuring mean? 
Configuring means that you create objects and determine the properties of these 
objects.  

What are objects? 
In this document objects is used as collective term for different items fulfilling 
certain tasks within the IP Office Contact Center system. An object has certain 
properties for these tasks. The properties of an object also depend on the task 
type the object is used for.  

Which objects are there? 
The following list shows all possible objects of a IP Office Contact Center 
system you can configure with the Configuration module. The objects are 
illustrated with icons. You also find these icons in the other modules of the IP 
Office Contact Center system.  

Object Icon 

Topic  
Agent group 

Virtual agent group 
 

 
Agent  
Agent profile  
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Object Icon 

Team  
Announcement  
Announcement script  
Voice unit  
Customer  
External destination  
Workplace  
Pause code  
PBX  
Country setting  
Queue device  
Telephone  
Telephone group  
CHAP server  
VEA  
Chat server  
Chat script  

What are task types? 
The task type  indicates the task a certain object is used for. You can use an 
object for several task types. You have to configure the respective properties for 
each task type.  

A IP Office Contact Center system supports the following task types.  

Task type Explanation 

Telephony Used for all telephony tasks. An agent uses a telephone 
to process telephony tasks. It makes no difference 
whether the agent uses an analog or a digital telephone or 
a PC with the telephony module.  

Email Used for all email tasks. An agent processes email tasks 
with the modul E-mail.  

Chat Used for all chat tasks. An agent processes chat tasks 
with the modul Chat. 

Where are data stored? 
All data are stored in a database. The database is located on a network computer. 
The respective computer must be entered in your server settings.  
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Structure of the Configuration module 
Like other Windows applications the Configuration module features menus, 
commands, and a tool bar.  

Opening the Configuration module 
The Configuration is included in the user interface.  

Prerequisite 

You must start the user interface before you can use the module. For information 
on how to do so, see the relevant documentation.  

Open 

To open the Configuration module, follow these steps. 

1. In the task bar click Administration. 

2. Click the  Configuration module. 

3. The Configuration module opens.  

or 

1. In the Window menu select Configuration. 

2. The module will open.  

Menus 
The following schematic illustration shows the menus  of the Configuration 
module. 

Configuration   System   Service   Window   Help 

Commands in the Configuration menu 
The following table shows the commands and functions of the Configuration  
menu. 

Command Function 

Topic Shows the configured topics. The Topic tab 
opens.  

Agent group Shows the configured agent groups. The 
Agent group tab opens.  

Agent Shows the configured agents. The Agent tab 
opens.  

Agent profile Shows the configured agent profiles. The 
Agent profile tab opens.  

Team Shows the configured teams. The Team tab 
opens.  

Customer Shows the configured customers. The 
Customer tab opens.  
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Command Function 

External destination Shows the configured external destinations. 
The External destination tab opens.  

Workplace Shows the configured workplaces. The 
Workplace tab opens.  

Announcement Shows the configured announcements. The 
Announcement tab opens.  

Announcement script Shows the configured announcement scripts. 
The Announcement script tab opens.  

Voice unit Shows the configured voice units. The Voice 
unit tab opens.  

Commands in the System menu 
The following table shows the commands and functions of the System menu.  

Command Function 

General Shows the system settings.  

Time off Shows the defined time off periods.  

Reporting settings Shows the reporting settings. 

Delete Reporting Data Shows a period for deleting reporting data.  

Realtime information 
default values 

Shows Realtime information default values. 

Variables Shows the defined variables.  

Tag list Shows the defined tags.  

Configuration report Shows the configuration report. 

Availability for Tasks 
(default) 

Shows the default settings for availability for 
task types. 

Skill overview Shows the skill overview. 

Interface for staff planning Shows the settings for the staff planning 
interface.  

Task Report Shows the settings for the Task report.  

Shift plan Shows the settings for the shift plan.  

Pause code Shows the pause code. 
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Commands in the Service menu 
The following table shows the commands and functions of the Service menu. 

Command Function 

Reporting filters Shows the reporting counters. 

Special settings Shows the special settings.  

Telephone default settings Shows the default telephone settings.  

Announcement Modules Shows the announcement modules.  

PBX Shows the configured PBXs.  

Country setting Shows the configured country settings. 

These settings are currently not required for 
IP Office Contact Center.  

Queue device Shows the configured queue devices. 

Telephone Shows the configured telephones. 

Telephone group Shows the configured telephone groups. 

CHAP server Shows the configured CHAP server. 

VEA Shows the configured Voice Extension 
Adapter. 

Access code agents Shows the selection codes of the PBXs for 
agents.  

Access code topics Shows the selection codes of the PBXs for 
topics.  

Email Settings Shows the email settings.  

Chat server Shows the settings for the chat server.  

Chat settings Shows the chat settings.  

Commands of the Window menu 
The following table lists all commands and functions of the Windows menu. 

Command Function 

Status bar Hides or shows the status bar.  

Save settings You can save the current settings. The same 
settings are used the next time you start the 
module. 
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Commands of the Help menu 
The following table lists all commands and functions of the Help menu. 

Command Function 

Contents Shows the Help contents. 

About Configuration Shows information about the Configuration 
module. 

List box 
A list box shows the objects configured for the specific task type.  

The respective objects are displayed for the following task types.  

Task type Object 

Telephony Shows the configured PBXs.  

Email Shows the configured email archives.  

Virtual Shows the configured virtual agent groups. 

Selecting an object 

You can select an object of a task type. The list of a tab shows only the objects 
configured for the respective task type.  

Select all 

If you select <All> all objects are displayed in the list of a tab.  

Tab 
For a clear presentation the objects are displayed on tabs. A tab lists the 
corresponding configured objects.  

In a tab you can use the following functions.  

• Edit 

• Add 

• Copy 

• Delete 

• Update 

• Columns 

Search fields 
You can use the search fields to search lists on a tab. Search fields are located at 
the bottom of lists.  

Status bar 
The status bar displays information about the selected command.  

You can show or hide the status bar.  

1. In the Window menu, select Status bar. The status bar is hidden 
or displayed.  
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Tools 
You learn how to work with the Configuration module and use special 
functions.  

Changing the name of an object 
Problems 
You can change the name of an object anytime. However, please keep in mind 
that the name of an object also defines the object explicitly in the Taskflow 
Editor module. Problems might arise if for example you change the name of a 
topic and this topic is used in a task flow set.  

No brackets ( ) [ ] { } 
Please note that you must not use any brackets for the name of an object.  

No characters @ " ' % ! \ < > | / ? = 

Please note that you must not use these characters for the name of an object.  
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Columns 
Objects, like topics or agent groups, are presented in tables. These tables show 
additional information on objects in columns.  

You can customize the column arrangement of these tables, change the order of 
columns and display or hide columns. You can also search for certain entries.  

Changing the order 

Objects in a table are always shown in alphabetical order. You can sort the 
display alphabetically according to any column. You can sort in ascending or 
descending order. Per default the information, e.g. names, is presented 
alphabetically. This means after A comes B then C etc. 

Proceed as follows to sort the table according to a certain column.  

1. Click the column heading.  

2. The table is sorted alphabetically according to this information, e.g. 
the number. The column heading shows the symbol  .  

3. Click the column heading again to change the order.  

4. The table is sorted in reverse order. The column heading shows the 
symbol  .  

Configuring the columns 

You can configure which information the table shows. The standard setting is 
used by default.  

Proceed as follows to configure the columns.  

1. In table, view click the Columns button. The Configuration of 
Columns dialog opens.  

2. Deselect Use defaults.  

3. You can customize the visible columns with the buttons <<< 
(insert) >>> (remove), Up and Down.  

4. Click OK to save your settings. The table of objects is then 
displayed with the configured columns.  

Searching in columns 

You can search a table for certain entries. You find respective search fields at the 
bottom area of the table. You can thus search a table containing many objects for 
specific objects with certain properties.  

Proceed as follows to search for an agent, for example, with a certain number.  

1. Enter "2", for example, in the search field for the number.  

2. The first entry found is selected in the table. In our case, an agent 
whose number starts with "2".  
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Using the keyboard 
You can execute the following functions with the keyboard.  

Function Action 

Selecting a list box Press the Space bar. 

To move to the next 
command or button 

Press the Tab key. Press Shift + Tab to return 
to the previous entry. 

To increase a numeric entry Press the Up arrow. 

To decrease a numeric entry Press the Down arrow. 

To select the maximum 
value of an entry 

Press the Page Up key. 

To select the minimum 
value of an entry 

Press the Page Down key.  

Working with the mouse 
You can execute the following functions with the mouse button.  

Function Action 

To edit an object Double-click the name of the object. 

To select multiple objects in 
sequence 

Click the first object of the list. Press the 
Shift key and keep it pressed. Click the last 
object of the list.  

To select several non-
successive objects 

Click the first object of the list. Press the Ctrl 
key and keep it pressed. Click the objects you 
want to select.  

To edit, create, copy, delete Click the name of an object with the right 
mouse button. A pop-up menu opens. Select 
the command.  
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Configuring topics 

What is a topic? 
A topic represents a service or task to carry out in the IP Office Contact Center 
system.  

A certain destination and a name identify a topic. A customer dials this 
destination.  

Every topic must be assigned to an agent group.  

You must enter topic name, VDN and agent group for a topic. You can further 
determine other settings for a topic.  

What does the Topic tab show? 
The Topic tab shows a list of all configured topics. The following information is 
listed. 

Header Explanation 

Name Shows the name of the topic. 

Tel Shows if a topic is configured for the task type 
Telephony.  

Email Shows if a topic is configured for the task type Email. 

Subscriber number Shows the number of the topic. 

active Symbol X indicates that the number has been set up in 
the CHAP configuration.  

PBX Shows the PBX of the topic. 

Email address Shows the email archive of the topic.  
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What do you need to configure a topic? 
Please note that you cannot configure a topic without an access code (external 
line code).  

How many topics can you configure? 
You can configure up to 4,000 topics in a PBX.  

Note that you need the necessary licenses.  

What do you need to change the name of a 
topic? 
You need the corresponding special privilege to change the name of an already 
configured topic.  

Which actions can you carry out on the Topic 
tab? 
You can initiate the following actions with the Topic tab. There is a button for 
each action.  

Action Explanation 

Edit Opens the selected topic. You can edit the properties. 

Create Creates a new topic.  

Copy Copies a selected topic.  

Delete Deletes a selected topic.  

Blocked periods Shows the blocked periods for the selected topic. You 
can edit the blocked periods. 
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Editing a topic: General tab 
You can configure name, task type, priority, blocked periods, variables and info 
in the general settings.  

The general settings are valid for all task types.  

Name 
Shows the name of the topic. You can use a topic name only once. You can use 
29 alphanumeric characters maximum.  

No brackets ( ) [ ] { } 

Please note that you must not use any brackets for the name of an object.  

No characters @ " ' % ! \ < > | / ? = 

Please note that you must not use these characters for the name of an object.  

Priority 
You can assign a priority to a topic. This priority is evaluated only if the IP 
Office Contact Center server handles call routing. You can set the priority 
between 0 and 100. 

Task type 
Shows the task type for which the topic is configured. You can configure a topic 
for the following task types. A new tab opens for each task type. You have to 
enter the respective settings.  

• Telephony 

• Email 

• Chat 

x blocked periods 
You can configure blocked periods for a topic. The number (x) shows how many 
blocked periods are defined. 

Variables 
Shows the variables for the object topic. You can add, change or delete variables. 

About 
Shows the topic information. You can define an info field and text for row 1 and 
row 2. 
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Editing a topic: Telephony tab 
You can configure the respective properties if you enable a topic for the task 
type Telephony.  

If you enable a topic for the Telephony task type, you must select a PBX. Note 
that you cannot change this setting later.  

Settings 
You have to configure the following settings.  

 

Setting Explanation 

VDN  

Access code 

Extension 

Specifies the VDN and extension. You configure 
VDNs (access codes) and the extension length in 
the PBX settings.  

Select a VDN.  

Enter an extension number.  

Once you click OK to save the topic, you can no 
longer change the VDN, extension or PBX.  

For further information about call number 
identification see the user manual System 
Administrator.  

PBX To select a PBX, select Telephony as the task type 
for a topic and click OK. You cannot change the 
PBX assignment later. 

Agent group For a PBX you can select an agent group for the 
topic. You need the allocation of an agent group for 
the ring timeout function for Last agent, Current 
agent and Personal contact.  

_D2HLink_162890 

ACW Shows the ACW. The ACW determines how soon 
an agent who answered a call for this topic is 
assigned the next call. The ACW starts at the end of 
a call.  

In the ACW box enter the default ACW for the 
topic.  

You can set the ACW between 0 and 180 seconds.  

Max. reservation time Shows the maximum reservation time. The 
maximum reservation time determines for how long 
a call to this topic is held.  

In the Max. reservation time box enter the 
maximum reservation time for this topic  

You can set the maximum reservation time between 
0 and 3,600 seconds.  
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Setting Explanation 

Distribute call after 
release by agent - max. 
times 

Shows the maximum number of times a call is 
rerouted if the agent releases the call. If 0 is set the 
call is not returned to call routing after the agent 
released the call. If 1 is set the call is returned to 
call routing once after the agent released it. The 
caller is e.g. connected to an automatic 
announcement (number).  

VIP topic Please note that this function has no consequence if 
the IP Office Contact Center server handles call 
routing.   

 

Script for playing voice 
mails 

Shows a script for voice mails. If a voice mail for 
the topic comes in this script is started. The script 
processes the voice mail. The script can play the 
voice mail for example.  

PBX cluster overflow 
topic 

Selects a topic as an overflow topic. You need an 
overflow topic in the PBX cluster.  

See also: Overflow topic in the PBX cluster 
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Job code 
You can configure job codes for the topic. You can determine the length of the 
job code and predefine codes. At a PC terminal these codes are then displayed in 
a list. This simplifies the input and allocation at a PC workplace. 

Reporting/Realtime information 
You can use the default values for reporting and realtime information or set other 
values.  

You determine the default values using the system settings. 

Skills 
You can select the agents’ skills for the task type Telephony.  

Routing 
You can set the hold time and minimum contact time for the last agent last agent 
function. You can also configure how the Last agent, Current agent and Personal 
contact objects are handled in IP Office Contact Center system routing. If the 
object are included in the kernel, you can define a sequence for the objects.  

Announcement 
You can assign four announcements to the topic. 

• Hold announcements 

• For dialed-in calls 

• For transferred calls 
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Editing a topic: Email tab 
You can configure the respective properties if you enable a topic for the task 
type Email.  

Mailbox 
Shows the topic mailbox.  

Max. time to accept 
Shows the maximum time to accept for emails in hours and minutes.  

The time to accept starts as soon as an email arrives at the agent’s folder.  

If the agent does not open an email (Outlook) before the maximum time for 
accepting is exceeded, the workplace is logged out of the distribution for all 
agent groups.  

Use the format hh:mm (hours, minutes). 

Max. reservation time 
Shows the maximum reservation time. The maximum reservation time 
determines for how long an email for this topic is held. 

The reservation time starts as soon as an email arrives in the agent’s folder.  

Use the format hh:mm (hours, minutes). You can set the maximum reservation 
time between 1 minute and 24:00 hours. 

Job code 
You can configure job codes for the topic. You can determine the length of the 
job code and predefine codes. At a PC terminal these codes are then displayed in 
a list. This simplifies the input and allocation at a PC workplace. 

Reporting/Realtime information 
You can use the default values for reporting and realtime information or set other 
values.  

You determine the default values using the system settings. 

Skills 
You can select the agents’ skills for the task type Email.  

Routing 
You can set the hold time and minimum contact time for the last agent last agent 
function. You can also configure how the Last agent, Current agent and Personal 
contact objects are handled in IP Office Contact Center system routing. If the 
object are included in the kernel, you can define a sequence for the objects.  
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Inserting the ticket ID in the subject 
You can automatically assign a number, the ticket ID, to new emails that are 
received in the topic.  

Ticket IDs are used to logically connect several customer requests and queries 
relating to the same transaction. 

If you select the check box, the ticket ID is inserted in the subject. The subject 
line is only updated when you reply or forward an e-mail. If you delegate an e-
mail, the subject is not changed. 

In order to activate the change, the service C3000 Client adapter must be 
restarted.  
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Editing mailbox details 
You configure the properties of the mailbox with the Mailbox Details dialog. 

Field Explanation 

Email Shows the mailbox email address.  

Reply to This field contains the reply address for a received email. 
If an agent uses the Reply function to reply to an email, 
the Reply to address in the MIME message is used. The 
Reply to address is not necessarily the sender's address. 
This option is primarily used to control replies to emails 
the agent sends or that are sent automatically. 

From This field lets the agent change his sender address. The 
topic address is usually used in this field. 

 Mailbox active If you select Mailbox active, emails are accepted and 
routed by this mailbox. 

If you do not select this option, emails that are routed in 
realtime to topics are processed until the topic does not 
contain any more emails. 

In the UMR web client, the topic is not available as a 
destination when delegating. 

SMTP protocol 
You do not need to make any more settings for the SMTP protocol. 

If you select Mailbox active, emails are received and then routed to the 
respective topic. 

If you do not select Mailbox active, emails are declined. An error message 
indicating that the mailbox is unavailable is sent to the upstream mail server 
(before UMR). Emails from customers to the company are received correctly by 
the upstream mail server. 

POP3 protocol 
You need to populate the following fields for the POP3 protocol. 

Field Explanation 

Mail server Specifies the name of the mail server. 

Port Port 110 is usually the default port.  

User Specifies the mailbox address. 

Polling interval Specifies the interval at which the unread messages are 
retrieved.  

Password Specifies the user's password. 

Confirm password Repeat the password. 

If you select Mailbox active, emails are retrieved by this mailbox and then 
routed to the respective topic. 

If you do not select Mailbox active, emails are received by the POP3 mailbox 
but not retrieved. Emails from customers to the company are received correctly 
by the upstream mail server. 
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IMAP4 protocol 
You need to populate the following fields for the IMAP4 protocol. 

Field Explanation 

Mail server Specifies the name of the mail server. 

Port Port 143 is usually the default port.  

User Specifies the mailbox address. 

Polling interval Specifies the interval at which the unread messages are 
retrieved.  

Password Specifies the user's password. 

Confirm password Repeat the password. 

Action Specifies the action that is carried out after messages are 
retrieved. 

Folders You can move messages to a folder. To do so, select the 
Move action. 

If you select Mailbox active, emails are retrieved by this mailbox and then 
routed to the respective topic. 

If you do not select Mailbox active, emails are received by the IMAP4 mailbox 
but not retrieved. Emails from customers to the company are received correctly 
by the upstream mail server. 
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Configuring a POP3 topic 
Before you begin, configure the email settings. 

When you use the POP3 protocol, the system retrieves messages from the inbox 
folder and then deletes them from the inbox folder. 

1. Click Configuration > Topic > Create. 

2. In the Topic - Create dialog box, enter a name for the new topic. 

For example: Info1 

3. Check the Email checkbox. 

4. Click the Email tab. 

5. Set the options and values as required. 

6. Click Details. 

The email address of the topic consists of the name and domain. 

7. Set the required options and enter addition information as necessary. 

8. Check the POP3 check box. 

9. Enter the following settings: 

a. In the MailServer field, enter the name of the mail server. 

b. In the Port field, enter 110. 

c. In the User field, enter the mailbox address. 

d. In the Polling interval field, enter the interval at which all 
messages are retrieved. 

e. In the Password field, enter the user’s password. 

f. In the Confirm password field, re-enter the password. 

10. Click OK. 

11. Click OK. 

Configuring an IMAP4 topic 
Before you begin, configure email settings. 

This feature does not work with Secure Password Authentication. 

1. Click Configuration > Topic > Create. 

2. In the Topic - Create dialog box, enter a name for the new topic. 

3. For example: Info1 

4. Check the Email checkbox. 

5. Click the Email tab. 

6. Set the options and values as required. 

7. Click Details. 

8. The email address of the topic consists of the name and domain. 

9. Set the required options and enter addition information as necessary. 

10. Check the IMAP4 check box. 

11. Enter the following settings: 

a. In the MailServer field, enter the name of the mail server. 
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b. In the Port field, enter 143. 

c. In the User field, enter the mailbox address. 

d. In the Polling interval field, enter the interval at which all 
messages are retrieved. 

e. In the Password field, enter the user’s password. 

f. In the Confirm password field, re-enter the password. 

g. In the Action field, specify the action to be carried out after 
messages are retrieved. 

h. In the Folders field, specify the folder to which you want to 
move the messages after they are retrieved. You must select 
the Move action. 

12. Click OK. 

13. Click OK. 

Enabling the POP3 or IMAP4 connector 
1. Open the Email configuration module. 

2. Click Components > C3000 POP3–IMAP4 Connector. 

3. In the C3000 POP3 IMAP4 Connector dialog box, enter the following 
settings: 

a. In the Maximum size of incoming messages (mega bytes) 
field, enter a limit for the incoming messages. The default is 2 
MB. The size also includes attachments, such as FAXes and 
bitmaps. If messages are not received, check the size of 
incoming messages and increase the limit if necessary. 
Coordinate this value with the customer’s email system 
administrator. The limit in the Unified Media component must 
be great than or equal to the customer’s email system limit. 

b. In the Maximum DB filling level in percent field, enter a fill 
percentage at which the system stops retrieving messages. 

c. In the Polling interval in minutes field, enter the time after 
which the gateway searches for new jobs. The default is 10 
minutes. 

4. Click Save. 

5. Click Close. 

6. Restart the service. 

Next Steps 

1. Send a sample email to the new email address you created for the 
topic. For example: Info1@company.com. 

2. Sign on the IP Office Contact Center as an agent user in the agent 
group defined. For example: AG-Info1. The test message should 
appear in the inbox folder. 

3. Use the UMR Administrator to manage email system connections 
and security. 
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Configuring Microsoft Exchange 

Connecting to a Microsoft Exchange server 
1. Click Start > Control Panel > Administrative Tools > DNS. 

2. Click DNS, then select the Exchange server. 

3. Click Forward Lookup Zones. 

4. Right-click on the domain name and click New Mail Exchanger... on 
the pop-up menu. 

5. In the Host or child domain field, enter a subdomain. 

6. In the Mail server field, enter the mail server on which the C3000 
SMTP connectoris running. 

7. Accept the default value in the Mail server priority field. 

8. Click OK. 

Creating a dedicated contact for each topic 
1. Click Start > All Programs > Microsoft Exchange > Active 

Directory Users and Computers. 

2. Click on the domain. 

3. Right-click Users and click New > Contact in the pop-up menu. 

4. In the Last Name field, enter a name for the topic contact. 

5. Accept the default settings. 

6. Click Modify. 

7. Select SMTP address as the email address type. 

8. Click OK. 

9. In the email address field, enter a UMR address. 

For example: service@umr.company.com 

Important: The user must also exist on the C3000. 

10. Click OK. 

11. Click Next. 

12. Click Finish. 

Creating a distribution group 
1. Click Start > All Programs > Microsoft Exchange > Active 

Directory Users and Computers. 

2. Click on the domain. 

3. Right-click Users and click New > Group in the pop-up menu. 

4. Under Group type, select Distribution. 

5. Under Group scope, select Universal. 

6. In the Group name field, enter a group name. 

For example: service 

7. Click Next. 
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8. Accept the default settings. 

9. Click Next. 

10. Click Finish. 

11. Double-click on the new distribution group or right-click and click 
Properties. 

12. Click on the General tab. 

13. In the E-mail field, enter an email address for the topic. 

For example: service@company.com 

14. Click OK. 

Adding contacts to a distribution group 
1. Click Start > All Programs > Microsoft Exchange > Active Directory 

Users and Computers. 

2. Double-click on a distribution group or right-click and select Properties. 

3. Click the Members tab. 

4. Click Add. 

5. Click Advanced > Find Now. 

6. Select one or more contacts and click Add. 

7. Click OK. 

8. Click OK. 

Adding a subdomain and a relay host 
1. Click Start > All Programs > Avaya > UMR Administrator > 

Components. 

2. Click the + in front of the computer and click C3000 SMTP 
Connector. 

3. Under Local accepted DNS domains, enter the subdomain created in the 
previous task. 

For example: umr.service.com 

4. In the Relay host for outgoing mails field, enter the relay host 
responsible for external email traffic on the Internet. 

5. Click Save. 

Configuring blocked periods 
You can configure blocked periods for a topic. The number (x) shows how many 
blocked periods are defined.  

You can create, change or delete blocked periods. 

What are blocked periods? 
You can evaluate blocked periods  in the Taskflow Editor. You have to use a 
logic unit to take the defined periods into account.  
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In the Taskflow Editor, blocked periods are used in a logic units. The term is 
q(?).blocked. The question mark is a placeholder for the topic. If the present time 
matches a blocked period for a topic, the term q(?).blocked is set to 1. 

Note 
Please note that other than holidays blocked periods are only valid for the 
selected topic. 

Which settings can you configure for blocked 
periods? 
You configure the following properties for blocked periods.  

 

 Property Explanation 
Repetition 

 None (one-time-only blocked 
period) 

 Daily (e.g. regular breaks) 
 Weekly 
 Yearly (e.g. national holidays) 

Specifies the repetition of blocked periods.  
You can select whether a break is to be repeated 
daily, weekly, yearly, or not at all. 
An example of a daily repetition is the daily lunch 
break from 12:00 p.m. to 12:30 p.m. 

Start of blocked period You can set the date and time you want a blocked 
period to start.  

If you set  Daily or  Weekly, you can only set 
the time.  
If you set  Weekly, you can select a day.  

You can enter the time or use  (up and down) to 
set the time.  

You can enter the date or click . A calendar in 
month view opens. A red circle  indicates 
today's date. A blue circle  indicates the set 
date.  

End of blocked period You can set the date and time you want a blocked 
period to stop.  
The settings are the same as for the start of the 
blocked period described above. The end of the 
blocked period must be after the start. 
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Configuring job codes 
You can choose whether you want to use job codes for a topic.  

If you want to use job codes select Use job code. The predefined job codes are 
displayed with code and name for the selected job code length.  

You can insert, change or delete job codes.  

What is a job code? 
You can enter a job code with every agent workplace. Job codes are used for 
reporting evaluations or to assign calls to certain processes and activities.  

With analog telephones the agent can enter a job code during the ACW. With 
digital telephones (TH13, TM13, TS13) and PC workplaces the agent can enter 
any number of job codes during the call or during the ACW.  

For a topic you can determine whether a job code has to be entered (mandatory 
job code). If the agent must enter a job code he is not assigned another call until 
the job code has been entered.  

Which settings can you configure for job codes? 
You can enter a fixed job code with a description.  

properties 
Property Explanation 
In this topic 

 Do not use job codes 
 Use job codes 
 Mandatory job code 

You can define whether a job code is used or 
whether a job code must be entered for the 
topic (mandatory job code).  

Job code length You can set the job code length between 1 and 
20 digits.  
 

Predefined codes A list shows the predefined job codes. You 
can insert, change and delete job codes.  

Code You can only use digits for the code. With job 
code length you determine the number of 
digits to be entered. 

Name Shows a description of the code. You can use 
29 alphanumeric characters maximum.  
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Configuring skills 
You can insert skills for each task type of a topic or an agent and define the 
respective skill levels.  

The Topic skills or Agent skills dialog shows the Skill tab.  

For information on skills and how to work with them, see What is skill-based 
routing?.  

Skill tab 
The Skill tab shows the defined skills with name and skill level.  

You can use the Skill tab to skills and skill levels to be valid for the respective 
topic or agent.  

Skills for task types 

You can configure skills for Telephony tasks for a topic and skills for Email 
tasks separately.  

Topic overflow 

You can select the following settings for a topic overflow.  

• Get original skills 

• Set own skills 

You can use the following four combinations.  

 

Option  Setting Explanation  

1. Option  Get original 
skills 

Skills or the dialed-in topic are 
deleted.  

  Set own skills The skills of the overflow topic are not 
added.  

2. Option  Get original 
skills 

Skills or the dialed-in topic are 
deleted.  

  Set own skills The skills of the overflow topic are 
added. 

3. Option  Get original 
skills 

Skills or the dialed-in topic are 
retained.  

  Set own skills The skills of the overflow topic are not 
added. 

4. Option  Get original 
skills 

Skills or the dialed-in topic are 
retained.  

  Set own skills The skills of the overflow topic are 
added. 

Please note that in the case of a dialed-in topic all skills of the dialed-in topic are 
added independent of the configuration of the Get original skills and Set own 
skills parameters. 

To delete skills specifically for a call or email you must use a tag operation to set 
the skill to zero in the task flow set.  
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Which actions can you execute with the Topic 
skills and Agent skills tabs? 
You can execute the following actions in the Topic skills or Agent skills dialog. 
There is a button for each action.  

Action Explanation 

Insert Opens the Select skill dialog. You can select a skill. 

Delete Deletes the selected skill.  

To change a skill you can edit the name and skill level directly in the list.  

The skill level shows how high the agent’s skills and knowledge have to be in a 
certain area, so that he is assigned the respective task (call or email). The skill 
level is given in percent. A minimum of 0 and a maximum of 100 percent are 
possible for a skill level.  

Skill 
The Select skill dialog shows the names of the skills of the tag list.  

You configure skills in the System menu under Tag list.  
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Skills-based routing optimization 
Use skills-based routing to connect call center customers to agents who are 
uniquely qualified to deal with their problems, questions and requests. Configure 
agent skills, skill levels and task flows to distribute contacts to the most qualified 
agents. 

To configure skills-based routing, you need to set skill tag names and then set 
topic and agent skill levels. 

Skills and skill levels 
Every call center agent has certain skills which consist of their knowledge and 
abilities. Skill levels quantify agent knowledge and abilities and indicate how 
good an agent’s skills are in a certain area. 

To configure skills-based routing, create skill topics that equate to knowledge 
and ability areas and set skill levels for each skill using percentages. Identify the 
skill levels required to manage customer calls and emails regarding specific 
topics and route those contacts to the appropriate agents. You can assign more 
than one skill to agents and topics. To route a contact, all criteria must be met. 
For example, the following list shows skills and skill levels for agents that are 
fluent in English, have some fluency in German, and do not speak French. 

 

Skill Skill Level 

Agent is fluent in English 100 

Agent is fluent in German 80 

Agent is fluent in French 0 

If you set up the task flow appropriately, when a customer calls and requires an 
agent that speaks French, the system will not route the call to an agent that does 
not speak French. 

Task Flows 
The system routes all incoming contacts for a specific topic to available agents in 
an agent group. When a contact requires an agent with specific skills, that affects 
how the system distributes contacts within the group. The system can use two 
different methods to determine how to distribute contacts to agents: 

• Default task flows 

• Customized task flows 

Default task flows 
By default, if you define agent skills for skill topics and do not change the task 
flows, the system distributes contacts to the best suited agent. When multiple 
criteria are required, the system uses the following formula to determine how to 
route the call:  

Total skill level = skill_1+skill_2+ ...+skill_n.  

If more than one agent has the same skill level, sometimes referred to as skill 
grade, the system chooses the agent with the highest agent group priority. The 
system sets priority by determining which agent has gone the longest time with 
no contact. Agents that lack at least one required skill are excluded from contact 
distribution. 
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Customized task flows 
Modify the default task flow to sort the agent group according to a certain skill 
and select ascending or descending order. Agents that lack the required skill 
level are excluded from contact distribution. The system determines the most 
qualified agent (descending order) or the agent with the minimum skill level 
(ascending order) to process the contact. Both kinds of sorting meet specific 
operational goals. Use descending order to assign agents that are best qualified to 
handle a topic. Use ascending order to ensure the most qualified agents remain 
available while training less skilled agents. 

In the case where no agents meet the criteria for an incoming contact, you can 
define a task flow to distribute the call to the most qualified agent. Use this 
method to temporarily reduce the skill level required for a contact. Use a static or 
global variable valid for all contacts or manage contacts dynamically within the 
task flow. 

Static call distribution 
Use the global variable g.skillFactor to temporarily reduce a skill level. If this 
parameter has a value less than 100, all skills for that topic are reduced by that 
factor. For example, if you set a skill level of 60% and g.skillFactor=50, the skill 
requirement is reduced to 30%. You can change the g.skillFactor during 
configuration or in real-time. 

Dynamic call distribution 
You can dynamically change skills and skill level values, defined with tags 
attached to an incoming contact, by changing the tags. You can lower the level. 
This method only affects the specific contact. 

Configuring skill tag names 
To use dynamic skills-based routing, configure skills by giving the skills 
descriptive tag names. 

1. Click System > Tag list > Add. 

2. In the Tag (Create) dialog box, enter a tag name. 

For example, A_speaks_German. 

3. Select Skill as the type. 

4. Click OK. 

The new tag appears is the list. 

5. Add more tags to the list if necessary. 

6. Click OK to save the tags. 

Configuring topic skills and skill levels 
Before you begin, you must configure skill tag names. 

1. Click Configuration and select the Topic tab. 

2. Double-click a topic to edit its properties. 

3. Click the tab of a task type. 

For example, click Telephony. 

4. Click Skills. 

5. In the Topic Skills dialog box, double-click a tag which equates to a 
skill. 
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6. Enter a skill level. 

The value determines the skill level as a percentage; 100 is the 
maximum level. Use this setting to specify the agent’s minimum skill 
level requirement to handle a contact tagged with that tag. 

7. Click OK. 

The tags and skill levels appear in the list. 

8. Add more skill levels as necessary. 

9. Click OK to save the skill configuration. 

Configuring agent skills and skill levels 
Before you begin, you must perform the following. 

• Configure skill tag names. 

• Configure topic skills and skill levels. You must configure skill levels 
for all skills for each each agent. 

1. Click Configuration and select the Agent tab. 

2. Double-click an agent to edit the properties. 

3. Click Skills > Add. 

4. In the Create skill dialog box, double-click a tag which equates to a 
skill. 

5. Enter a skill level for a skill. 

The value determines the skill level as a percentage; 100 is the 
maximum level. Use this setting to specify the agent’s skill level for 
this skill. 

6. Click OK. 

The skill levels appear in the list. 

7. Add more skill levels as necessary. 

8. Click OK to save the configuration. 

Using statistical values in the task flow 
Use statistical values in task flows to control call distribution. Adjust call 
distribution by setting service level thresholds in the task flow. Use the TSF or 
Accept level setting to adjust thresholds. In contact centers where only the 
acceptance rate must be guaranteed, use the Accept level setting. 

Configure a statistical value consisting of TSF, accessibility, and average wait 
time as a variable in the Monitor_srv process and store it in the database. After 
restarting the system, the last stored variable will be used. The first update 
occurs after 15 minutes to allow sufficient statistical values to collect for a 
reliable calculation. 

Note: The monitor values are valid for the Telephony task type. 

Configure the following parameters in a topic: 

1. Configure the TSF parameter Mon_TSF with a start value of 100. 

2. Configure the Accept level parameter Mon_AcceptLevel with a start 
value of 0. 

3. Configure the Average wait time parameter Mon_AvgTConvWait with 
a start 21 value of 0. 



 

46  •  Configuring topics Using IP Office Contact Center  Configuration Tool 

Scenario: Routing calls based on an agent’s 
product knowledge 
This scenario describes the system uses skills-based routing to distribute contacts 
to agents based on a specific level of product knowledge. In this scenario, skill 
tag names were set up using the Telephony task type and three agents are signed 
on and available. Without sorting according to skill, the system determines the 
most qualified agent by using the following formula: knows product A+knows 
product B. 

The following skills are configured for a topic called 4711 in this scenario: 

• Knows product A 

• Knows product B 

For an incoming contact tagged with topic 4711, an agent must have a skill level 
of 50% for product A and a skill level of 70% for product B in order to be 
connected to the contact. 

 

 Skill: Knows product A Skill: Knows product B 

Topic skills and skill levels 

4711 50 70 

Agent skills and skill levels 

Agent 1 90 70 

Agent 2 70 80 

Agent 3 40 100 

Routing without sorting according to skill 
Without any task flow configuration and based on the settings above, the system 
handles contacts as follows: 

• Agent 1 and Agent 2 get calls related to topic 4711. 

• The agent who has been available for the longest period of time 
receives calls first. 

• Agent 3 does not get any calls for topic 4711. 

Routing with descending sorting according to skill 
With a task flow configured with a descending sort, the system handles the 
contacts as follows: 

• Agent 1 gets calls for topic 4711 if he is available. 

• Agent 2 gets a call for topic 4711 only if Agent 1 is not available. 

• gent 3 does not get any calls for topic 4711. 

Configuring routing 
You can set the hold time and minimum contact time for the last agent last agent 
function. You can also configure how the Last agent, Current agent and Personal 
contact objects are handled in IP Office Contact Center system routing.  
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Options for routing calls and emails 
If you use the kernel process 

The kernel process processes calls and emails for assigned objects.  

The sequence of objects determines the priority. The top object has first priority, 
the next has second priority and so on. 

If you use the vectors process 

The vectors process processes calls and emails for assigned objects.  

You must define how calls and emails are routed in terms of the last agent, 
current agent and personal contact in the task flow.  

Recommendation for high load systems 
To reduce the load in high load systems and reduce the number of calls and 
emails routed by the vectors process, we recommend using the rules defined for 
the last agent, current agent and personal contact objects in the kernel process.  

Last agent function 
The times for configuring the last agent are entered in this dialog. 

Action Explanation 

Hold duration Shows the hold duration for emails in hours and minutes. 
Use the format hh:mm (hours, minutes). 

The hold duration defines how long the assignment 
between the caller or sender and agent is saved. For calls 
the duration begins after the conversation ends. For 
emails the duration begins after the email is sent.  

Minimum contact 
time 

Shows the minimum contact time for emails in hours and 
minutes. Use the format hh:mm (hours, minutes).  

The minimum contact time defines the minimum time a 
contact between the caller and agent must exist or the 
minimum time an agent must process an email. If the 
minimum contact time is not reached, a call or email is 
not included in the last agent function.  

Routing functions 
You can compile lists for task flow (vectors) and automatic (kernel) as required.  

Button Explanation 

>>> Inserts the selected object in the Automatic list (kernel).  

<<< Inserts the selected object in the task flow list (vectors).   

Up 

Down 

Use Up and Down to determine the priority when you 
use the kernel process to route objects.  

 

Creating a keyword-based email routing task 
flow 
You can create a task flow that distributes emails based on words contained 
within them. 
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Configure a script and create an email flow. The script can contain up to 10 
keyword patterns. The system evaluates each keyword pattern separately. A 
keyword pattern can contain 200 keywords. The system executes the script 
checking the text of the email for designated keywords and if it finds a match, 
then it sets a special task tag to true. 

1. Create a script. 

a. Click Start > All Programs > Avaya > UMR Administrator. 

b. Click the E-Mail script tab. 

c. Click Add. 

d. In the Name field, enter a name for the script.  

The script name can contain up to 29 alphanumeric characters. 

e. To add a keyword pattern, click Add. 

Patterns can include special characters. 

f. To edit a keyword pattern, click the Edit button. 

g. Click Apply to apply the keywords. 

h. Click Save. 

2. Test the keyword pattern. 

a. In theEdit configuration dialog box, click Test. 

b. In theText configuration dialog box, enter a text message. 

c. Click Test. 

d. Click Close. 

3. Create an email task flow. 

a. Click Start > All Programs > Avaya > Task Flow Editor. 

b. Create an E-mail flow with the E-Mail script and Task Tag 
elements. 

c. Save the task flow set. 

d. Activate the task flow set. 

e.  

Configuring announcements 
You can assign announcements to direct incoming or transferred calls to the 
topic. You can choose from DSPF or voice unit (VU) texts or MHX1 to MHX4 
(music on hold).  

You have to configure the announcement texts first.  

You can only use this feature for the task type Telephony.  

For hold announcements you can select either a voice unit announcement script 
or a time slot (MHX).  

What are direct incoming calls? 
Direct incoming calls are calls to the topic directly via the VDN.  



 

Using IP Office Contact Center  Configuration Tool Configuring topics  •  49 

What are transferred calls? 
Transferred calls are calls that originally dialed into another topic and were 
transferred to this topic by an agent or the call distribution.  

Which settings can you configure for the 
announcement text assignment? 
A list shows the following information for the selected type.  

• Number 

• Name 

• Interruptible 

You can insert, delete, play and change the sequence of announcement texts.  

What are hold announcements? 
Hold announcements are announcements played to subscribers while they wait.  
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Editing a topic: chat tab 
You can configure the respective properties if you enable a topic for the task 
type chat.   

You have to configure a user in the chat server. This user is a chat topic in the IP 
Office Contact Center system. You will need the username and password in 
order to identify the user.  

Settings 
You have to configure the following settings. 

TaskServer 

Select a chat taskserver. If a chat taskserver is configured, then it is 
automatically usesd. A chat taskserver can manage one chat server.  

Jabber Identifier 

A Jabber Identifier enables addressing a user on a chat server.  

The scheme if a Jabber Identifier has the follwing form,  

Example:  

topic1@domain.com/ipocc 

Node @ Domäne / Resource 

The first part is the address of the node. Node represents the user name. Enter the 
user name. The complete Jabber Identifier is composed of the IP Office Contact 
Center system. The domain is derived from the selected taskserver. The IP 
Office Contact Center system uses ipocc as resource.  

Password 

Enter the password of the user of the chat server.  

Announcement text 

Enter an announcement text.  

Automatic text at 
You can select an automatic text for the following states. An automatic text is 
configured as chat script.  

• Reject 

• Hold 

• End 

Job code 
You can configure job codes for the topic.  

Reporting/Realtime information 
You can use the default values for reporting and realtime information or set other 
values.  

You determine the default values using the system settings. 
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Skills 
You can select the agents’ skills for the task type chat. 
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Configuring agent groups 

What is an agent group? 
An agent group consists of a group of agents. An agent group processes tasks for 
one or several topics. An agent group distributes a call to the next available 
agent. Agents have to sign on to the agent group. Calls are distributed to agents 
either according to hierarchical or available-time criteria. 

Please note that some settings are valid for internal call distribution only. 

What does the Agent group tab show? 
The Agent group tab lists all configured agent groups. The following 
information is listed. 

Header Explanation 

Name Shows the name of the agent group. 

Virt. AG AG Shows whether the agent group is a virtual agent group. 

Tel Shows whether an agent group is configured for task type 
Telephony.  

Email Shows whether an agent group is configured for task type 
Email. 

PBX Shows the PBX of the agent group. 

How many agent groups can you configure? 
You can configure 250 agent groups maximum for one PBX.  

Note that you need the necessary licenses.  
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What do you need to change the name of an 
agent group? 
You need the corresponding special privilege to change the name of an already 
configured agent group.  

Which actions can you execute with the Agent 
group tab? 
You can execute the following actions with the Agent group tab. There is a 
button for each action.  

Action Explanation 

Editing Opens the selected agent group. You can edit the 
properties. 

Create Creates a new agent group.  

Create virtual AG Creates a virtual agent group. 

Copy Copies the selected agent group.  

Delete Deletes the selected agent group.  
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What is a virtual agent group? 
To route calls over several PBXs in a call center network, you can combine some 
physical agent groups to form a virtual agent group.  

In a virtual agent group agents are only assigned indirectly. 

For further information see also: Creating a virtual agent group 

Assignment 
The following rules apply to the assignment.  

• A physical agent group can be assigned to only one virtual agent 
group.  

• A virtual agent group can work for several physical agent groups.  

• The physical agent groups of a virtual agent group can be of 
several PBXs or just one PBX.  

• Physical and virtual agent groups can be assigned to an agent.  

Agent signon and signoff 
If an agent signs on to or off from a physical agent group the agent is also signed 
on to or off from assigned virtual agent groups.  

If several physical agent groups with the same virtual agent group are configured 
for an agent, the agent is signed on to the virtual agent group as soon as he signs 
on to the first physical agent group.  

The agent is signed off from the virtual agent group as soon as he signs off from 
the last physical agent group.  

If an agent is signed on to a virtual agent group via the UI, all physical agent 
groups of the assigned virtual agent group are signed on as well.  

Priority 
The priority of a virtual agent group for an agent matches the most important 
(lowest) priority of the assigned signed-on physical agent group.  

The following actions change the priority of a virtual agent group.  

• Changing the priority of a physical agent group 

• Signing on to or off from a physical agent group 

• Adding or removing a physical agent group for an agent 

• Configuring or deleting the assignment of a physical agent group 
with a virtual agent group 
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Task flow set 
Routing in a task flow set via a virtual agent group matches the behavior of a 
routing via a physical agent group. For assignment to an agent only one of the 
assigned, signed-on, physical agent groups is signaled to the PBX. PBXs know 
only the physical agent groups.  

Note on Realtime information 
The Realtime information area of the user interface shows agent group-
dependent realtime information, like the realtime agent status information for 
virtual agent groups and physical agent groups.  

Icon 
The Configuration module uses the following icon for virtual agent groups.  
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Editing an agent group: General tab 
With the general settings you can configure name, task type, variable and the 
assignment to a virtual agent group.  

The general settings are valid for all task types. 

Name 
Shows the full name of the agent group. The name must be unique system-wide. 
You can use 29 alphanumeric characters maximum. 

No brackets ( ) [ ] { } 

Please note that you must not use any brackets for the name of an object.  

No characters @ " ' % ! \ < > | / ? = 

Please note that you must not use these characters for the name of an object.  

Task type 
Shows the task types of the agent group. You can configure an agent group for 
the following task types. A new tab opens for each task type. You have to enter 
the respective settings.  

• Telephony 

• Email 

• Chat 

Variables 
Shows the variables for the object virtual agent group. You can add, change or 
delete variables. 

Virtual agent group 
Shows whether the agent group is assigned to a virtual agent group. 

You can select a virtual agent group for the agent group. An agent group can be 
assigned to only one virtual agent group. 
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Editing an agent group: Telephony tab 
You can configure the respective properties if you enable an agent group for the 
task type Telephony.  

View option 
Shows the name of the agent group. You enter the name with the general 
settings.  

PBX 
Shows the PBX. If more than one PBX is configured, you must select a PBX 
when you create the task type Telephony.  

Number 
Shows the number of the agent group at the PBX. The PBX assigns the number. 
a free number to the agent group. When you delete an agent group the respective 
number is free again.  

Call distribution 
Specifies the type of routing.  

Hierarchical 

Hierarchical means that within a priority level the call is assigned to the agent 
who signed on to the agent group with this priority first. If this agent is not 
available the call is assigned to the agent who signed on second etc. The next 
priority level is searched only if no agent of the respective level is available. 

Available longest 

Incoming calls to the agent group are assigned to available agents who signed on 
to the agent group with priority 1. The call is signaled at one terminal only. 
Available longest means that calls are assigned to available agents with the same 
priority successively, so that an even distribution within a priority level is 
achieved. 

If all agents of an agent group with priority 1 are busy the agents with priority 2 
are taken into account next. 

This procedure is repeated until all priority levels of the agent group are checked. 

Depending on the number of calls and the average wait time in the queue, 
additional calls can overflow to another queue. 

In the case of an overflow the call is queued into another queue. Seen from the 
original queue an assignment referring to available time is no longer possible. 

If several agents are available the call distribution assigns new calls in 
chronological order, that is according to available times. The agent who has been 
available longest is assigned the next call.  
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Idle time description 

The idle time (longest available) is ACD call related.  
Idle time starts: agent signs on to first agent group 
Idle time is reseted: agent signs off from last agent group 
Idle time is reseted: agent is working for ACD and gets free 
Idle time is reseted: agent ends pause 
Idle time is reseted: ACW ends (does not matter if automatic or manual) 

Direct calls does not affect the idle time, neither inbound nor outbounds calls. So 
if a receptionist transfers a call directly to an agent the idle time continues 
because it is a none-ACD-call.  

Queue factor 
Specifies the queue factor. The queue factor and the number of agents signed on 
to the group determine the size of the agent group queue. Calls that cannot be 
queued get busy tone. Enter the queue factor in the Queue factor input box.  

50 is the maximum value.  

Note that the queue factor is only evaluated for routing using the IP Office 
Contact Center system.  

Overflow factor 
Specifies the overflow factor in percent. Incoming calls are transferred to the 
defined overflow groups if the queue load in percent exceeds the defined 
overflow factor. Enter the overflow factor in % in the Overflow factor input box.  

100 % is the maximum value.  

Announcement factor 
Specifies the announcement factor in percent. As soon as the position of a call in 
the queue is below the announcement factor, the call is connected to a defined 
announcement. Enter the announcement factor in % in the Announc. factor input 
box.  

100 % is the maximum value.  

Ring timeout 
Specifies the ring timeout in seconds. A workplace is signed off from the call 
distribution for all agent groups, if a call is not answered until ring timeout. An 
agent is also logged out, if a signoff prevention is configured. In the Ring 
timeout box, enter the time in seconds after which a workplace is to be signed 
off from call distribution.  

The ring timeout configured for the agent group assigned to the topic is always 
used. It does not matter which agent group processes the call.  

180 seconds is the maximum value.  
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Urgent info 
Specifies the three values for urgent information in percent.  

If the load on the queue exceeds one of the values normal, medium or high, this 
information is given to a PC or TH13 workplace. 

Signaling threshold 
Specifies the signaling threshold in percent. 

Enter in this box from which degree of change of the queue the realtime 
information display of this agent group is to trigger an update. (0% = after every 
change, 30% = only after a 30% change in the queue). The signaling threshold is 
only valid for telephone not for PC terminals.  

30% is the maximum value.  

Routing number 
Displays an alternative routing number. A call to the agent group is transferred 
to the defined number via trunk or tie line. 

Agents can be assigned to this agent group but no agent can sign on to the group 
if a routing number is entered. It is thus possible e.g. to redirect an agent group 
with assigned agents for a certain time without having to change the assignment 
of agents. 

Signoff prevention 
Shows how many agents have to remain signed on to the agent group. Only as 
many agents as permitted by the quota can sign off. No further agent of this 
agent group is allowed to sign off. The signoff prevention is suspended, if the 
ring timeout  is exceeded. 

255 is the maximum value.  

Overflow groups 
Displays the overflow groups. Up to four groups can be entered as overflow 
groups in the input field. Calls are transferred to the next defined overflow group 
as soon as the overflow factor is exceeded. The order of the list determines the 
order of the overflow groups. 

Night service group 
<None> or the configured night service groups are listed.  

During night service, calls to the agent group are forwarded to another agent 
group, the night service group. Night service for an agent group is automatically 
activated as soon as the last agent of the group signs off from call distribution.  



 

60  •  Configuring agent groups Using IP Office Contact Center  Configuration Tool 

Reporting/Realtime information 
You can use the default values for reporting and realtime information or set other 
values.  

You determine the default values using the system settings. 

Agents 
Shows the agents assigned to this agent group with priority, name and number. 



 

Using IP Office Contact Center  Configuration Tool Configuring agent groups  •  61 

Editing an agent group: Email tab 
You can configure the respective properties if you enable an agent group for the 
task type Email.  

Signoff prevention 
Shows how many agents have to remain signed on to the agent group. Only as 
many agents as permitted by the quota can sign off. No further agent of this 
agent group is allowed to sign off. The signoff prevention is suspended, if the 
ring timeout  is exceeded. 

255 is the maximum value.  

Agents 
Shows the agents assigned to this agent group with priority, name and number. 

Reporting/Realtime information 
You can use the default values for reporting and realtime information or set other 
values.  

You determine the default values using the system settings.  
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Editing an agent group: chat tab 
You can configure the respective properties if you enable an agent group for the 
task type chat.  

Agents 
Shows the agents assigned to this agent group with priority, name and number. 

Reporting/Realtime information 
You can use the default values for reporting and realtime information or set other 
values.  

You determine the default values using the system settings. 
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Creating a virtual agent group 
A distinction is made between physical and virtual agent groups. 

A physical agent group is permanently assigned to a PBX. Thus only agents of 
this PBX can sign on to this agent group.  

Multiple physical agent groups can be assigned to one virtual agent group. 
Agents of several PBXs can thus work for one virtual agent group.  

Restriction 

A physical agent group can be assigned to only one virtual agent group.  

Prerequisites 
In order for a virtual agent group to be available across several PBXs certain 
prerequisites are necessary.  

You need to configure a physical Call Center network across several PBXs and 
create and configure the connections between the PBXs. You will need network 
lines between the PBXs which are appropriately configured in the PBXs. Calls 
can then be transferred from one PBX to another. You need to carry out these 
configuration steps in the PBXs and in the IP Office Contact Center system.  

For further information see:  

• Editing a PBX 

• PBX cluster 

Notes on assigning agents 
In order to implement a Call Center network and assign physical agent groups 
from different or the same PBXs you need to configure the physical agent 
groups, and assign the physical agent group to a virtual agent group. The 
configuration part of the virtual agent group only shows the allocation of the 
physical agent group.  

Configuration using an example 
To set up a virtual agent group:  

Step 1 
1. Click the Agent group tab or choose Agent group in the 

Configuration menu.  

2. Click Create virtual AG. The [virtual agent group] - Create 
dialog opens.  

3. Enter a name for the virtual agent group.  

4. You can assign variables or TaskTags to a virtual agent group, and 
those can be used in the CallFlow set. These variables or TaskTags 
can be queried from the CallFlow set and used for other purposes. 
To insert a variable click Variable.  

5. To save your settings click OK. The virtual agent group is now 
configured.  
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Step 2 

Now you can assign the virtual agent groups to the agent groups.  

1. Click a (non-virtual) agent group which you have created.  

2. Click  in the General tab.  

3. Double-click the virtual agent group you have created.  

4. Click OK to save the settings  

5. Repeat steps 1 to 4 for all agent groups that you want to combine in 
a virtual agent group.  

Example: Variable for virtual agent group 
You can allocate variables and TaskTags to a virtual agent group.  

Example 

Every 10th caller to the virtual agent group hears a greeting.  

Procedure 
Add a variable to the virtual agent group. In the CallFlow set increase the value 
of this variable for each call to the agent group. You can now check the CallFlow 
set to see whether this call will be answered by a greeting before the call gets 
routed to an agent in the virtual agent group.  

Settings for virtual agent group 
Virtual agent group 
Shows the name of the virtual agent group. 

Shows the physical agent groups assigned to this virtual agent group. 

Variables 

Shows the variables for the object agent group. You can add, change or delete 
variables. 

Assignment 

On the General tab for a physical agent group, you can assign the agent group to 
a virtual agent group.  
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Configuring agents 

What is an agent? 
Any user of the IP Office Contact Center system is called an agent. It makes no 
difference whether the user is working with a telephone or a correspondingly 
equipped PC.  

Please note that depending on the task type the agent uses different tools (e.g. a 
telephone).  

What does the Agent tab show? 
The Agent tab lists all configured agents. The following information is listed. 

Header Explanation 

Name Shows the agent’s name 

Tel Shows whether an agent is configured for the task type 
Telephony.  

Email Shows whether an agent is configured for the task type 
Email. 

Subscriber number Shows the agent’s number. 

Email address Shows the agent’s email address. 

PBX Shows the agent’s PBX. 

How many agents can you configure? 
You can configure up to 1,000 agents maximum in a PBX. 
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Which actions can you execute with the Agent 
tab? 
You can execute the following actions with the Agent tab. There is a button for 
each action.  

Action Explanation 

Editing Opens the selected agent. You can edit the properties. 

Create Creates a new agent.  

Copy Copies the selected agent.  

Delete Deletes the selected agent.  

Editing an agent: General tab 
The General tab lets you define the general properties for an agent.  

The general settings are valid for all task types. 

System name 
Shows the display name within the system. Assign a name to the agent. The 
name must be unique system-wide.  

You can use 29 alphanumeric characters maximum. 

No brackets ( ) [ ] { } 
Please note that you must not use any brackets for the name of an object.  

No characters @ " ' % ! \ < > | / ? = 

Please note that you must not use these characters for the name of an object.  

Login name 
Name and password identify an agent upon login.  

You can use 29 alphanumeric characters maximum. 

Alias 
Shows the agent’s alias. You can use this alias with the Reporting module for 
anonymous reporting. The agent usually creates his own alias.  

You can use 29 alphanumeric characters maximum. 
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Automatic Login through Windows User 
Account 
You can configure an agent so that the agent is identified in the IP Office 
Contact Center system with his/her Windows user account. The agent can then 
start the Contact Center User Interface application without having to log in to 
the IP Office Contact Center system.  

This function is also called a single sign-on (SSO) or one-time login.  

User Name 

Shows the Windows user name. The login name is automatically incorporated.  

Domain/Computer 

Indicates the domain or the computer which the user is login into. The selection 
list shows previously used domains or computers.  

Language 
Specifies the language for IP Office Contact Center modules. IP Office Contact 
Center modules open in the respective language (menus, commands, dialogs).  

Assign a language to the user by clicking it in the list. After login, all language-
specific parts (including regional formats) of the system are presented in the 
selected language. 

Task type 
Shows the task types for which the agent is configured. You can configure an 
agent for the following task types. A new tab opens for each task type. You have 
to enter the respective settings.  

• Telephony 

• Email 

• Chat 

Last name 
Shows the agent’s last name. You can use 29 alphanumeric characters 
maximum. 

First name 
Shows the agent’s first name. You can use 29 alphanumeric characters 
maximum. 

Employee ID 
Specifies the agent’s employee ID. If you want you can enter the user’s internal 
company code. This entry is optional.  

You can use 29 alphanumeric characters maximum. 

Cost center 
Specifies the agent’s cost center. If you want you can enter the user’s internal 
company cost center. This entry is optional.  
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You can use 29 alphanumeric characters maximum. 

Title 
Specifies title  for the agent. You can select either Mr. or Mrs.. The selected title 
is passed on to the module.  

Predefined profile 
Specifies a predefined profile or <None> for the agent. 

You can use a predefined profile for the agent. Please note that changing the 
predefined profile will affect this agent.  

You cannot change the group assignment and authorization of a predefined 
profile with the agent configuration. You have to change these settings with the 
Agent profile configuration. 

Address book profile 
Address book profiles let you define which agents can read which address books 
and which they can import.  

The address book profile serves also for the phone book function in the module 
Firstscreen.  

Password 
Specifies the agent’s password. The agent can change his password anytime. 

Password conditions 

The password must contain at least eight characters.  

To keep the password secret an asterisk (*) is displayed for each digit when the 
password is entered.  

For security reasons, there is no default password.  

You must enter a password.  

You can use the following types of characters in the password:  

• Lower case letters 

• Upper case letters 

• Digits 

• Special characters 

You must use characters from at least two of these groups.  

Sample password 

MyPassword_01 

This example uses characters from all groups.  

2. Password 
For an agent with "four-eye principle" privilege you have to enter a password for 
a second person.  

Please note that the second person cannot change this password.  
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If you do not have the "4-eye-princple" privilege, you cannot configure this 
setting.  

Variables 
Shows the agent's variables. You can add, change or delete variables. 

Skills 
The Agent skills dialog shows skills and skill levels defined for the agent. The 
agent’s skills are valid for all task types. 

You can insert, change and delete skills.  

You can change a skill directly in the list by changing name and skill level.  

The skill level shows how high the agent’s skills and knowledge are in a certain 
area. The skill level is given in percent. A minimum of 0 and a maximum of 100 
percent are possible for a skill level.  

Availability 
For each task type the Availability for Tasks dialog shows which conditions 
have to be met so that no further tasks are assigned to the agent.  

You can customize the settings for an agent or use the default settings. You 
determine the default settings for Availability for Tasks with the System menu.  

For further information see Availability for Tasks.  

Privileges 
You can change or view the agent’s privileges.  

For further information please refer to: Which privileges are there? 



 

70  •  Configuring agents Using IP Office Contact Center  Configuration Tool 

Authorization 
Shows the agent's authorizations. You can determine which topics, agent groups, 
agents, teams and workplaces the agent can work with.  

Topic 

You set which topics the agent can use. 

Agent group 

You set which agent groups the agent can use. 

With the AG (agent group) authorization it is determined for which agent groups 
an agent can process tasks if he has the Select AG privilege. 

For agents with privileges like Realtime information, Reporting or Agent group 
configuration, AG authorization determines for which agent groups they can 
execute these functions. 

Agent 

You set which agents the agent can configure. 

The agent needs to have the Agent configuration privilege. 

Team 

You set which teams the agent can configure. 

Telephone 

You set which workplaces the agent can use.  

Telephone group 

You set which telephone group  the agent can use.  

Campaign 

You set which campaign the agent can edit and view in the module dialer.  
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Editing an agent: Telephony tab 
A subscriber (also called DTE xxx) is an agent for the task type Telephony. 

An agent can be work with a telephone or a PC.  

A PC is connected to the PBX. You can use the full scope of the Configuration 
module.  

You can configure the respective properties if you enable an agent for the task 
type Telephony.  

Telephony name 
Shows under which name the agent is configured at the PBX.  

You can use 18 alphanumeric characters maximum. 

PBX 
Shows the PBX. If several PBXs are configured you need to select a PBX when 
you create the task type Telephony.  

Subscriber number 
You can enter the call number optional.  

Number of connections 
Shows the number of connections. You can choose between 1, 2 or 30 
connections. During external call distribution, only the number 1 is supported, a 
different setting can lead to errors.  

ACW 
Shows the ACW. 

The ACW determines when an agent who processed a call for this agent group is 
assigned the next call. The ACW starts at the end of a call.  

You can increase or decrease the ACW for the agent in percent.  

You can increase the ACW up to 999% maximum. 

You configure the ACW when you configure topics. 

100% is set as the default for the ACW.  

Routing logout 
Specifies the number calls are transferred to if the agent is not logged in to the IP 
Office Contact Center system.  
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Group assignment 
Shows the agent groups the agent or the agent profile for the task types 
Telephony or Email are assigned to. You can use a priority between 1 (highest) 
and 5 (lowest) for each agent group. You can select the priority directly in the 
list.  

You can insert or delete agent groups and change the order with the Up and 
Down buttons.  

Password 
Specifies the agent's password for the telephone. To keep the password secret an 
asterisk (*) is displayed for each digit when the password is entered.  

The password can consist of maximally nine numbers. 
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Editing an agent: Email tab 
You can configure the respective properties if you enable an agent for the task 
type Email.  

Mailbox 
Shows the agent’s mailbox. You can change the properties.  

Click the Details button to specify the mailbox details.  

Mailbox details 
You can specify the following details for a mailbox.  

 

Setting Explanation 

Email Shows the agent's email address.  

Reply to Specifies the reply address for a received email. If an 
agent uses the Reply function to reply to an email, the 
Reply to address is used. The Reply to address is not 
necessarily the sender's address. This option is primarily 
used to control replies to emails the agent sends. 

From Shows the agent’s sender address.  

Group assignment 
Shows the agent groups the agent is assigned to for the task type Email. A 
priority between 1 (highest) and 5 (lowest) can be defined for each agent group.  

You can insert or delete agent groups and change the order with the Up and 
Down buttons.  
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Editing an agent: Chat tab 
You can configure the respective properties if you enable an agent for the task 
type Chat.  

Settings 
You have to configure the following settings. 

TaskServer 

Select a chat taskserver. If a chat taskserver is configured, then it is 
automatically usesd. A chat taskserver can manage one chat server.  

Welcome text 

Select a welcometext. A  welcome text is configured as chat script. 

Group assignment 
Shows the agent groups the agent is assigned to for the task type Chat. A priority 
between 1 (highest) and 5 (lowest) can be defined for each agent group.  

You can insert or delete agent groups and change the order with the Up and 
Down buttons.  
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Which privileges are there? 
Privileges are divided into tabs.  

What are privileges? 
Privileges let you control which modules in the IP Office Contact Center system 
an agent can use and which actions the agent can carry out within the modules. 
You can also determine whether the agent my pass on his privileges or not.  

Setting privileges 
Proceed as follows to set privileges.  

1. On the Agent tab, double-click an agent.  

2. Click Privileges.  

3. Select privileges. You can assign certain privileges to an agent. The 
agent can only pass on his privileges to other agents if you also 
select the corresponding P (pass on) box.  

4. Click OK to enable the privileges.  

What does P mean? 
P stands for pass on. You can choose whether an agent may pass on the 
respective privilege or not.  
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Privileges: Agent 
You can set the following privileges for an agent.  

Privilege Meaning 

Change password The agent can change his password. 

Change alias The agent can change his alias. The 
alias can be used for reporting 
evaluations. 

Call routing logged-out user The agent can activate a call routing 
for the time he is logged-out. 

Automatic sign on (Tel.) The agent (e.g. an answering 
machine) is automatically signed on 
to call distribution. 

Agent group assignment The agent can assign himself to an 
agent group.  

Terminal pause controls e-mail pause If the privilege Terminal pause 
controls e-mail pause is set for an 
agent, then if the agent set pause with 
the terminal automatically pause is 
set for e-mail.  

Job code input The agent can enter a job code.  

This privilege is not needed for IP 
Office Contact Center PBXs. The 
adjustment is set in the topic. 

Mandatory job code input The agent must enter a job code for 
every call. The agent stays in ACW 
until a job code is entered. If you 
select Mandatory job code input you 
also have to select Job code input or 
the agent cannot enter a job code.  

This privilege is not needed for IP 
Office Contact Center PBXs. The 
adjustment is set in the topic. 

Outgoing job code  The agent can enter a job code for 
outgoing calls.  

Extend wrap-up time The agent can extend the ACW.  

Chat  

Automatic sign on The agent is automatically signed on 
to all assigned agent groups.  

Advanced archive view The agent Can use the chat archive.  

Server-specific  
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Privilege Meaning 

Four-eye principle With this privilege certain data can 
only be surveyed by two persons at a 
time. A second password is required 
to retrieve this data. Two passwords 
have to be defined in the agent 
configuration. An agent with the 
four-eye principle cannot log in on 
his own. He can only log in together 
with a second person (second 
password). 
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Privileges: UI 
You can set the following privileges for the UI.  

Privilege Meaning 

Home  

Select own home file If you select the Select own home 
file privilege, the agent can select 
which realtime information he wants 
to view. 

Home configuration If you select the Home 
configuration privilege, the agent 
can configure realtime information 
for all agents. 

First screen  

Select own first screen If you select the Select own first 
screen privilege, the agent can select 
which first screen he wants to view.  

First screen configuration If you select the First screen 
configuration privilege, the agent 
can configure first screens for all 
agents.  

Change own contact bar If you select the Change own 
contact bar privilege, the agent can 
change his own contact bar. 

Contact bar configuration If you select the Contact bar 
configuration privilege, the agent 
can configure the contact bar for all 
agents. 

Show quick bar If you select the Show quick bar 
privilege, the quick bar is displayed.  

Select own quick bar If you select the Select own quick bar 
privilege, the agent can select a file 
for the quick bar. 

For further information see Manual 
User Interface.  

Cockpit bar  

Show cockpit bar If you select the Show cockpit bar 
privilege, the agents can see the 
cockpit bar. 

Change own cockpit bar If you select the Change own 
cockpit bar privilege, the agent can 
change his own cockpit bar. 

Cockpit bar configuration If you select the Cockpit bar 
configuration privilege, the agent 
can configure the cockpit bar for all 
agents.  

Status bar  
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Privilege Meaning 

Change own status bar If you select the Change own status 
bar privilege, the agent can change 
his own status bar. 

Status bar configuration If you select the Status bar 
configuration privilege, the agent 
can configure the status bar for all 
agents. 
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Privilege Meaning 

UI config  

UI configuration If you select the UI configuration 
privilege, the agent can configure his 
own UI. The UI Config module 
appears in the task bar and can be 
used.  

Change default settings If you select the Default interface 
privilege, the agents see the default 
interface.  

UI Config. Application With the UI Config. Application, 
privilege the agent can select an 
active view. After starting the 
application Contact Center User 
Interface, the selected view starts 
automatically, for example, 
Monitoring.  

In the UI configuration of a system, 
profile or agent, the Application tab 
also appears with the privilege. You 
can select the active view in the 
Application tab.  

Grid color configuration Agents can configure background 
and text colors.  

Privileges: UMR 
The following privileges are required for UMR. Note that these privileges 
determine whether or not you can use individual functions. 

Privilege Meaning 

UMR administrator If you possess this privilege, you can 
use the following functions:  

Email configuration 

Address book administration 

The relevant icons will appear under 
Administration in the task bar. 

Keyword based E-Mail routing If you have this privilege, then you can 
configure scripts for e-mail with text 
search keywords.  

The privilege UMR administrator 
includes the privilege Keyword bases E-
mail routing.  

Textblock administrator If you possess this privilege, you can 
use the Text block administration 
module. For details of how to perform 
this role, see the relevant topics in the 
online help or the manual. 



 

Using IP Office Contact Center  Configuration Tool Configuring agents  •  81 

Privilege Meaning 

UMR supervisor If you possess this privilege you can 
work as a supervisor. As a supervisor 
you can use the following functions.  

In the Overview folder 

- Delete document 

- Delegate document to agents 

- Delegate document to topics 

In the Deleted folder 

- Delegate document to topic  

Dictionary 

- Manage 

- Import 

Use textblocks If you have this privilege, you can use 
text blocks in documents. The text 
blocks are set up using the Text block 
administration module.  

Defer e-mails If you possess this privilege you can put 
documents on hold. These documents 
will then be placed in the Held folder.  

Print e-mails If you possess this privilege you can 
print documents.  

Agent queue view This privilege gives the agent an 
overview of the email queue for his 
authorized topics. The agent can select 
emails from this queue. 

Delete e-mails With this privilege, agents can delete 
active emails. Once deleted, these 
emails cannot be retrieved. 

Automatic sign on With this privilege, you are 
automatically logged into the agent 
group configured for you. 

Advanced archive view With this privilege, agents can display 
mailboxes of deleted agents or topics in 
the Archive folder.  

Reply as agent With this privilege, an agent can choose 
whether to reply as a topic or an agent. 
The corresponding email address is then 
used as the sender.  

Privileges: Configuration 
You can set the following privileges for the Configuration module.  

Privilege Meaning 

Configuration The agent can start and use the Configuration 
module.  

Topic The agent can configure topics. 

Blocked periods The agent can configure blocked periods. 
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Privilege Meaning 

Agent group The agent can configure agent groups. 

Agent The agent can configure agents. 

Edit alias The agent can edit the alias if the agent can configure 
agents. 

Agent profile The agent can configure agent profiles. 

Team The agent can configure teams. 

Workplace The agent can configure workplaces.  

Skill The agent can configure skills.  

Announcement The agent can configure announcements. 

Announcement script The agent can configure announcement scripts. 

Voice unit The agent can configure voice units. 

Chat script The agent can configure chat scripts. 

Customer recognition The agent can change and enter data for the customer 
recognition. 

External destinations The agent can change and enter external destinations. 

System The agent can configure general system settings. 

Interface for staff 
planning 

The agent can configure the interface for staff 
planning.  

Configuration report The agent can create a configuration report.  

Shift plan The agent can configure the shift plan.  

Delete statistic data The agent can delete the statistic data.  

 

Service privilege Meaning 

Reporting filters The agent can configure reporting filters. 

Special settings The agent can configure special settings. 

Telephone settings The agent can configure telephone default settings. 

Announcement module The agent can configure announcement modules. 

PBX The agent can configure PBXs. 

Country  The agent can configure country settings. 

Queue device The agent can configure queue devices. 

Telephone The agent can configure telephones. 

CHAP server The agent can configure CHAP servers. 

Access code agents The agent can configure access codes for agents. 

Access code topics The agent can configure access code topics. 

E-mail settings The agent can configure email settings. 

Chat server The agent can configure the settings for the chat 
server.  

Chat settings The agent can configure chat settings. 
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Privileges: Variables 
You determine whether the agent can configure variables for certain objects 
(configuration). You can further determine whether the agent may change the 
value or not (Assign values). You can change the value in the Realtime 
information area of the user interface if you have the necessary privilege. 

You can configure variables for the following objects if you have the necessary 
privileges. 

• Global 

• Topic 

• Agent group 

• Agents 

• VU script 

• External destinations 
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Privileges: Reporting 
The following privileges are needed for the Reporting module.  

Privilege Meaning 

Team leader  

Reporting The agent can start and use the Reporting module. 

Topic The agent can create reports on topics. 

Agent group The agent can create reports on agent groups. 

Agent The agent can create reports on agents. 

Show alias only The agent can create reports on agents using aliases. 

Team The agent can create reports on teams. 

Telephone The agent can create reports on workplaces. 

Trunk Line The agent can create reports on lines. 

Outbound ACD The agent can create reports on outgoing ACD 
connections. 

Voice unit The agent can create reports on voice units. 

Skill The agent can create reports on skills. 

System The agent can create reports on the system. 

PBXs The agent can create reports on PBXs. 

Automatic reporting The agent can create automatic reports. 

Delete data The agent can delete the reporting data of a certain 
period.  

Set report parameters The agent can open predefined reports in the 
Inspector and adjust the report period. 

Supervisor  

Definition The agent can configure the file manager to create 
new reports, for example. 
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Privileges: Realtime information 
The following privileges are required for the Realtime information module.  

Agent 
Note that you need the necessary license.  

Privileges Meaning 

Callback from call list The agent can use the Callback from call 
list function.  

Switch The agent can use the Switch function.  

Pick up call The agent can use the pick up call 
function.  

Switch/reserve from queue The agent can use the Switch/ reserve 
from queue function. He can accept or 
switch tasks from the queue or reserve 
them for himself or other agents.  

Team leader 
Note that you need the necessary license.  

Privileges Meaning 

Realtime information The agent can start and use the Realtime 
information module.  

Remote functions The agent can use the remote functions. 
For information on the available 
functions, see the user manual or Online 
Help. 

Trunk realtime information The agent can use the trunk realtime 
information function.  

Out of office notice The agent can edit the out of office notice 
of other agents.  
Note: To use this function the agent needs 
also the privilege Variable – Agents.  

Agent history The agent can use and edit the agent 
history.  

Supervisor 
Note that you need the necessary license.  

Privileges Meaning 

Configuration The agent can use the Configuration 
function to create or change private or 
system-wide realtime information. 

Supervisor Emergency The agent can use the Supervisor 
Emergency function. To be able to 
configure the function as well, the agent 
also needs the Configure Supervisor 
Emergency privilege. 

Silent Monitoring The agent can use the Silent Realtime 
information or Coaching function in the 
telephone contact bar. 

Supervisor Assistance The agent can use the Supervisor 
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Privileges Meaning 
Assistance and the Silent Monitoring 
functions.  
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Privileges: Taskflow Editor 
The following privileges are required for the Taskflow Editor module. 

Privilege Meaning 

Task Flow Editor The agent can start and use the 
Taskflow Editor module.  

Edit task flow set This privilege lets you edit a task flow 
set. If this privilege is not selected you 
have read-only access. 

Activate task flow set In the case of a system failure the IP 
Office Contact Center system uses a 
default task flow set. This default task 
flow set is protected separately. This 
privilege lets the agent edit and change 
the default task flow set. 

Use default task flow set This privilege lets you define a task 
flow set as the default task flow set.   

Edit predefined conditions  With this privilege the agent can edit 
and change these predefined conditions.  
A user can edit private conditions 
without a special privilege. 

Advanced mode The Taskflow Editor has a license called 
Feat_CC_extUI. This license enables an 
advanced mode for the Taskflow Editor. 
You must have this license to use the 
following elements.  

- Logic 

- Distributor (equal) 

- Distributor (cyclic) 

If you do not have the license or the 
Advanced mode privilege, you cannot 
open task flow sets with these elements.  
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Configured privileges: Others 
The following privileges are needed for the other modules in the IP Office 
Contact Center system. 

Privilege Meaning 

Dialer The agent can start and use the Dialer 
module. 

Wallboard The agent can start and use the 
Wallboard module. 

IVR-Editor The agent can start and use the IVR-
Editor module. 

Addressbook Admin The agent can start and use the 
Addressbook Admin module. 

Task reporting  

Agent evaluation The agent can use non-call-related agent 
events. 

Contact evaluation The agent can use Contact evaluation. 

Start/stop reports The agent can start or stop reports. 
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Configuring agent profiles 

What is an agent profile? 
An agent profile includes group assignment, authorizations, privileges and 
telephone. Agent profiles makes it possible to administer these settings 
comfortably for several agents.  

The settings are explained below. 

Agent profiles have an inheritance mechanism. You can use this mechanism for 
the following functions. 

• for inheritance 

• for assigning the same profile to multiple agents 

• as a tool 

Using inheritance 
If you assign a profile to several agents and change the settings of this profile, 
the agents’ settings are automatically changed as well. 

Assigning the same profile to several agents 
You can conveniently create a number of agents with the same settings. You do 
not have to configure the settings for each agent individually.  
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Using profiles as tools 
Even if each agent uses different settings you can use profiles as templates to 
configure common settings, e.g. keys. Assign the profile to the agent first. All 
settings of the profile are copied. Then select <None> as predefined profile. The 
profile settings are kept. You only have to make the differing settings. It does not 
affect the new customized settings if the original profile is changed later. 

What does the Agent profile tab show? 
The Agent profile tab lists all configured agent profiles. The following 
information is listed. 

Header Explanation 

Name Shows the name of the agent profile. 

Tel Shows whether an agent profile is configured for the task 
type Telephony.  

Email Shows whether an agent profile is configured for the task 
type Email. 

PBX Shows the PBX of the agent profile. 

How many agent profiles can you configure? 
You can configure any number of agent profiles. Please pay attention to the size 
of the database. 

When is it not possible to delete a profile? 
Please note that you cannot delete an agent profile as long as one or several 
agents are using this profile. 
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Which actions can you execute with the Agent 
profile tab? 
You can execute the following actions with the Agent profile tab. There is a 
button for each action.  

Action Explanation 

Editing Opens the selected agent profile. You can edit the 
properties. 

Create Creates a new agent profile.  

Copy Copies the selected agent profile. The following settings 
will be copied.  

• Contact bar 

• Cockpit bar 

• Home 

• First screen 

• Status bar 

• Application 

• Realtime information 

Delete Deletes the selected agent profile.  

Update in the UI configuration 
If you work in the user interface with the module UI configuration, then 
changes of the profiles (new profile, deleted profile) are not immediately visible. 
You need to update the view (Right click - Update).  
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Editing an agent profile: General tab 
You determine the general settings of an agent profile with the General tab.  

Name 
Shows the name of the agent profile. Give the agent profile a name. This name 
must be unique system-wide.  

You can use 29 alphanumeric characters maximum. 

Task types 
You can configure an agent for the following task types. A new tab opens for 
each task type. You have to enter the respective settings.  

• Telephony 

• Email 

• Chat 

Used for 
Shows the agents using the profile.  

Privileges 
Shows the privileges of the agent profile. 

Authorization 
Shows the authorizations of the agent profile. You determine which topics, agent 
groups, agents, teams and workplaces the agent profile can use.  

Topic 

You determine which topics the agent can use. 

AG 

You determine which agent groups the agent can use. 

With the AG (agent group) authorization it is determined for which agent groups 
an agent can process tasks if he has the Select AG privilege. 

For agents with privileges like Realtime information, Reporting or Agent group 
configuration, AG authorization determines for which agent groups they can 
execute these functions. 

Agent 

You set which agents the agent can configure. 

The agent needs to have the Agent configuration privilege. 

Team 

You set which teams the agent can configure. 

Telephone 

You set which workplaces the agent can use.  

Telephone group 
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You set which telephone group  the agent can use.  

Campaign 

You set which campaign the agent can edit and view in the module dialer.  
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Editing an agent profile: Telephony tab 
You can configure the respective properties if you enable an agent profile for the 
task type Telephony.  

PBX 
Shows the PBX. If several PBXs are configured you need to select a PBX when 
you create the task type Telephony.  

Group assignment 
Shows the agent groups the agent is assigned to for the task type Telephony. A 
priority between 1 (highest) and 5 (lowest) can be defined for each agent group.  

You can insert or delete agent groups and change the order with the Up and 
Down buttons.  

Settings 
Shows the telephone settings. If you deselect Use default settings, you can 
change the settings.  

See also: Telephone default settings 

Editing an agent profile: Email tab 
You can configure the respective properties if you enable an agent profile for the 
task type Email.  

Group assignment 
Shows the agent groups the agent is assigned to for the task type Email. A 
priority between 1 (highest) and 5 (lowest) can be defined for each agent group.  

You can insert or delete agent groups and change the order with the Up and 
Down buttons.  

Editing an agent profile: Chat tab 
You can configure the respective properties if you enable an agent for the task 
type Chat.  

Settings 
You have to configure the following settings. 

TaskServer 

Select a chat taskserver. If a chat taskserver is configured, then it is 
automatically usesd. A chat taskserver can manage one chat server.  

Announcement text 

Enter an announcement text. 
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Group assignment 
Shows the agent groups the agent is assigned to for the task type Chat. A priority 
between 1 (highest) and 5 (lowest) can be defined for each agent group.  

You can insert or delete agent groups and change the order with the Up and 
Down buttons.  
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Configuring teams 

What is a team? 
A team usually consists of several agents. You can use the Realtime 
information module to monitor teams and use the Reporting module to 
evaluate them. You can also use teams to subdivide large agent groups for 
realtime information and reporting purposes. 

You can add or remove selected agents. You can also execute these functions by 
double-clicking an agent.  

What does the Team tab show? 
The Team tab lists all configured teams. The list shows the following 
information. 

Header Explanation 

Name Shows the name of the team. 

How many teams can you configure? 
You can configure any number of teams. Please pay attention to the size of the 
database. 

How many members can a team have? 
A team can have any number of members. Please pay attention to the size of the 
database. 

Which actions can you execute with the Team 
tab? 
You can execute the following actions with the Team tab. There is a button for 
each action.  

Action Explanation 

Editing Opens the selected team. You can edit the properties. 

Create Creates a new team.  

Copy Copies the selected team.  

Delete Deletes the selected team.  
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Editing a team: General tab 
You determine the general settings of a team with the General tab.  

Name 
Shows the name of the team. Enter a name for the team.  

You can use 29 alphanumeric characters maximum. 

No brackets ( ) [ ] { } 

Please note that you must not use any brackets for the name of an object.  

No characters @ " ' % ! \ < > | / ? = 

Please note that you must not use these characters for the name of an object.  

Team members 
Shows the team members.  

Other agents 
Shows the agents who are not members of the team. 
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Editing a team: Telephony, Email, Chat tab 
You can configure the respective properties if you enable a team for the task 
types Telephony or Email or Chat.  

Realtime information settings 
Shows the realtime information settings. You can use the defaults or change the 
values. 

Wait time threshold for TSF 
Enter the wait time in hours and minutes (hh:mm) after which a call or email or 
chat request is counted as having waited in the queue for too long. Every call or 
email or chat request that has to wait for more than the duration set reduces the 
TSF. This setting is also valid for reporting.  

The queue of the task type Email is the topic mailbox.  

Calculating period of time 
Shows the calculated period of time. You can change this value with the 
Realtime information default values.  
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Configuring announcements 

What is an announcement? 
An announcement text is playable text or music. The announcement text can be a 
wav file. The wav file is stored in the database.  

What does the Announcement tab show? 
The Announcement tab lists all configured announcements. The list shows the 
following information. 

Header Explanation 

Name Shows the name of the announcement. 

PBX Shows the PBX in which the announcement is 
configured.  

Status Shows the status of the announcement. 

No. Shows the number of the announcement. 

Enable Shows whether the announcement is enabled for a certain 
topic or for all topics.  

Interr. Shows whether the announcement is interruptible or not. 

Duration Shows the duration of the announcement. 
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Which actions can you execute with the 
Announcement tab? 
You can execute the following actions with the Announcement tab. There is a 
button for each action.  

Action Explanation 

Editing Opens the selected announcement. You can edit the 
properties. 

Create Creates a new announcement text. You can configure the 
properties.  

Delete Deletes the selected announcement text.  
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Editing an announcement 
You can edit the announcement texts of an announcement.  

How many announcement texts can you 
configure? 
You can configure up to 500 announcement texts.  

Creating or changing an announcement text 
You can create or change an announcement text.  

The following table lists the settings and provides explanations.  

Setting Explanation 

Name Shows the name of the announcement text. Enter a 
name for a new announcement text or change the 
name of an existing text. If a text with the same 
name already exists, the old announcement text is 
overwritten. You can use 29 alphanumeric 
characters maximum. 

Text number Shows the sequential number of this announcement 
text. 

Sound file Shows a sound file. You can use an existing sound 
file. You can only use wav files.  

Duration Shows the length of the announcement test in 
mm:ss (minutes:seconds). 

Interruptible Activate this checkbox if you want the 
announcement text to be interruptible, e.g. if an 
agent becomes available during the announcement 
or music. 

Comment Specifies a comment. You can enter a description 
for the announcement text file.  

Status Shows the state of the announcement text. The 
following states are possible. 

Not transferred. 

No WAV file was transferred for this text number. 

Transfer interrupted Interr. 

The transfer of the WAV file was interrupted. 

Transferred 

Transfer completed without errors. 

Newly transferred. 

An old WAV file was replaced by a new WAV file. 

Supported WAV format 
We recommend the following WAV format.  

PCM 8,000 kHz, 16 bit, Mono 
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PBX: Announcement 
Shows the PBX. If several PBXs are configured you need to select a PBX when 
you create an announcement.  
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Configuring announcement 
scripts 

What is an announcement script? 
To be able to use announcement texts in the Taskflow Editor, you have to 
create announcement scripts. The Taskflow Editor can then use these 
announcement scripts for task flow processing. Please note the difference 
between announcement scripts and announcement texts. 

An announcement script can consist of several announcement texts.  

What are announcement texts? 
All announcement texts in the list are played to the caller one after the other. 
After all announcement texts have been played the last text of the chain is 
repeated until replay is stopped (e.g. the call is connected to a free agent). To 
change the position of an announcement text in the chain select the text and 
move the mouse pointer to the new position between two other texts. When the 
mouse pointer changes to a double arrow press the left mouse button to drop the 
text to its new position. 

Was does the Announcement script tab show? 
The Announcement script tab lists all configured announcement scripts. The 
list shows the following information. 

Header Explanation 

Name Shows the name of the announcement script. 

Welc. Shows if this script is a welcome announcement. 

PBX Shows the PBX in which the announcement script is 
configured.  

How many announcement scripts can you 
configure? 
You can configure any number of announcement scripts.  
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Which actions can you execute with the 
Announcement script tab? 
You can execute the following actions with the Announcement script tab. 
There is a button for each action.  

Action Explanation 

Editing Opens the selected announcement script. You can edit 
the properties. 

Create Creates a new announcement script.  

Copy Copies the selected announcement script.  

Delete Deletes the selected announcement script.  
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Editing an announcement script 
You can set the properties of an announcement script. You can further play and 
add announcement texts and move them up or down in the list.  

Name 
Shows name of the announcement script. You can use 29 alphanumeric 
characters maximum.  

No brackets ( ) [ ] { } 

Please note that you must not use any brackets for the name of an object.  

No characters @ " ' % ! \ < > | / ? = 

Please note that you must not use these characters for the name of an object.  

Attention when using 1x announcements 

If the announcement script is used for a 1x announcement, you can only use 22 
alphanumeric characters for the name. If you do not take this into account, the 
task flow using this 1x announcement script cannot be activated. The reason is 
that when the announcement script is created, a tag with the name 
Script_<Name> is automatically created. Tags have a maximum length of 29 
characters.  

IVR Script 

It should be no IVR script with the same name.  

Welcome announcement 
You can select if the announcement script is a welcome announcement.  

If an announcement script is marked as welcome announcement, it is not counted 
as wait time in reporting.  

If an announcement script is not marked as welcome announcement, it is counted 
as wait time in reporting.  

Free of cost 
The announcement script is free of cost for the caller (no cahrge).  

At the end of script 
You can choose whether the last text is to be repeated at the end of the script or 
if the announcement is to be stopped.  

Repeat last text 

After all announcement texts have been played the last text of the chain is 
repeated until replay is stopped (e.g. the call is connected to a free agent).  

Automatic stop 

The announcement is stopped after all announcement texts have been played.  
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Announcement texts 
Shows number, name and interruptible. 

Interruptible means that the announcement text can be interrupted, e.g. if an 
agent becomes available during the announcement or music. 

Which actions can you execute with the Edit 
Announcement Script tab? 
You can execute the following actions with the Edit Announcement Script tab. 
There is a button for each action.  

Action Explanation 

Play Click the Play button to listen to an announcement text. 
The announcement text is played on the handset.  

Insert Shows the configured announcement texts with number, 
name and interruptible. 

You can select one or several announcement texts.  

Delete Deletes the selected announcement text.  

Up Moves the selected announcement text up. 

Down Moves the selected announcement text down. 

Inserting an announcement text 
If you click the Insert button of the Edit Announcement Script dialog, the 
Select Announcement Text for Script dialog opens.  

The Select Announcement Text for Script dialog shows the configured 
announcement texts with number, name, interruptible and the PBX. 

You can select one or up to 5 announcement texts. 
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Configuring a 1x announcement 
In previous releases announcement scripts did not have an exit connector. In 
release 4.0 and later, you can configure 1x announcement scripts and use them in 
task flow sets. A 1x announcement script has an exit connector. You can thus 
determine an alternative flow with the task flow set.  

Until release 4.0 a subscriber heard ringing tone after an announcement script 
with welcome announcement. You can now prevent this with a 1x 
announcement script.  

You can use 1x announcement scripts in a task flow set. You need to take the 
following points into account for a 1x announcement.  

• You have to select the option  Repeat last text.  

• You have to insert at least two announcement texts. The first 
announcement text usually contains the text, e.g. a welcome text. 
This text must not be interruptible. The second announcement text 
(silence) does not contain text You can use several announcement 
texts but the last text (silence) must not contain text.  

• Only the last text (silence) must be interruptible. Select the 
Interruptible option. 

• You can use 22 alphanumeric characters maximum for the name of 
a 1x announcement script. If you do not take this into account, the 
task flow using this 1x announcement script cannot be activated. 
The reason is that when the announcement script is created, a tag 
with the name Script_<Name> is automatically created. Tags have 
a maximum length of 29 characters.  
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Configuring voice units 

What is a voice unit? 
A voice unit  adds features like announcements, speech recognition, and 
interaction with the caller via DTMF to the functional range of the IP Office 
Contact Center system. DTMF stands for Dual Tone Multi Frequency Dialing.  

A voice unit is installed on a PC with hardware and software. The PBX is 
connected with the voice unit via a line (e.g. S2M with 30 B-channels).  

The voice unit creates scripts for the unit with the corresponding software. The 
VU process offers access to these scripts. This process runs on the IP Office 
Contact Center server. The scripts can be used in task flow processing. 

What does the Voice unit tab show? 
The Voice unit tab lists all configured voice units. The list shows the following 
information. 

Header Explanation 

Name Shows the name of the voice unit. 

PBX Shows the PBX in which the voice unit is configured.  

How many voice units can you configure? 
You can configure any number of voice units.  

Which actions can you execute with the Voice 
unit tab? 
You can execute the following actions with the Voice unit tab. There is a button 
for each action.  

Action Explanation 

Editing Opens the selected voice unit. You can edit the 
properties. 

Create Creates a new voice unit.  

Copy Copies the selected voice unit.  

Delete Deletes the selected voice unit.  
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Editing a voice unit 
You can configure the properties of a voice unit.  

Properties of a voice unit 
You configure the following properties for a voice unit in a IP Office Contact 
Center system.  

 
Settings Explanation 
Name Specifies the name of the voice unit. You can use 

29 alphanumeric characters maximum.  

PBX  Shows the PBX. If you have configured a voice 
unit, you cannot change this setting.  

Type  You can select Voice Control or <External> as the 
type.  

Version  Specifies the version of the interface protocol. For 
Voice Control, enter 1.070. 

Host Shows the host name of the voice unit. You can 
also use the IP address.  

Mail server Specifies the host name of an SMTP-capable mail 
server. This mail server is used by Voice Control 
to send emails.  

Standard script  
Shows the standard script. If an error occurs, it is 
started by Voice Control.  

 Ok 
 

Confirms your entries and closes the dialog.  

 Cancel 
 

Closes the dialog without applying the changes.  

 Scripts 
 

Opens the VU scripts dialog. The dialog shows 
the configured VU scripts.  

 Voice mail 
 

Opens the Voice mails dialog. The dialog shows 
the configured voice mails.  

 Insert 
 

Inserts a line (telephone number of the channels).  

 Replace 
 

Replaces a line.  

 Delete 
 

Deletes a line.  

 Up 
 

Moves the selected line up in the sequence.  

 Down 
 

Moves the selected line down in the sequence.  
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PBX-specific settings that must be entered 

The following lists indicate the settings you must enter based on the PBX you 
are using.  

IP Office Contact Center and Voice Control 

• Name 

• PBX 

• Host 

• Mail server 

• Default script 

• Scripts 

• Voice mails 
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Line allocation 
Shows the line allocation of the voice unit.  

The list shows the following information. 

• Line 

• B-channels 

• Port 

You can add, replace, delete, or move the line up and down the list.  

Scripts 
The following information is provided.  

• Name 

• Type 

• Welc. 

• Accessible 

Editing the properties of a VU script 
If you select a VU script in the Voice Unit Scripts dialog and click the 
Properties button, the Voice Unit Script - Name of voice unit script dialog 
opens.  

Properties 

You can view the following properties. Use the IVR Editor module to define the 
settings for an IVR script. Announcement is the default type.  

If you are using a version 1.060 voice unit or earlier, you can also edit the 
properties.  

Type 

• Undefined 

• Announcement 

• Welcome announcement 

• Automatic agent 

Accessible 

• Yes 

• No 

Variables 

Shows the defined variables.  

1x announcement 

You can use the VU script (1x announcement) element in the task flow set.  
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Voice mails 
Shows the current voice mails of the selected voice unit.  

The list shows the following information.  

• Date / Time 

• Done 

• Type 

• Name 

• Customer 

• Length 

• Topic 

You can delete a voice mail.  

Click on Details, to display any tags stored for the voice mail. 



 

Using IP Office Contact Center  Configuration Tool Configuring customer recognition  •  113 

Configuring customer 
recognition 

What is a customer? 
Customer recognition provides agents with preliminary information regarding 
the calling party.  

How is a customer identified? 
A customer's numbers or email addresses are used for identification. After the 
identification the database is searched for customer information and the 
information is offered to the agent.  

What does the Customer tab show? 
You can choose normal or extended view for the table. You can sort the list by 
clicking the headers.  

View: normal 

The Customer tab lists all configured customers. The list shows the following 
information. 

Header Explanation 

Name Shows the customer’s name. 

Customer number Shows the customer’s number.  

Prio Shows the customer’s priority.  

Company entry Shows whether there is a company entry for the 
customer.  
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View: extended 

The Customer tab lists all configured customers. The list shows the following 
information. 

Header Explanation 

Name Shows the customer’s name. 

Number/email Shows the customer’s number or email address.  

Type Shows the type. 

Type Shows the kind of number or email.  

Prio Shows the customer’s priority.  

Company entry Shows whether there is a company entry for the 
customer.  

Customer number Shows the customer’s number.  

How many customers can you configure? 
You can configure any number of customers. Please pay attention to the size of 
the database.  

Which actions can you execute with the 
Customer tab? 
You can execute the following actions with the Customer tab. There is a button 
for each action.  

Action Explanation 

Editing Opens the selected customer. You can edit the properties. 

Create Creates a new customer.  

Delete Deletes the selected customer.  

Man Import Imports customer data.  

Auto Import Imports customer data automatically in certain cycles.  
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Editing a customer 
You can set the properties for a customer.  

Name 
Shows the customer’s name. You can use 40 alphanumeric characters maximum. 

Customer no. 
Shows the customer number. You can use 29 alphanumeric characters 
maximum.  

Prio 
Shows the customer’s priority. The priority is appended to the message (call or 
email). You can evaluate this priority with in task flow processing (routing) and 
route the call accordingly. You can e.g. assign a higher priority to more 
important customers. 

Company entry 
Determines how a customer is recognized if the configured numbers or email 
addresses are used.  

Valid for the type Telephony 
You can e.g. enter a company number for a company (e.g. 0071113586) and in 
addition enter individual employees with their full numbers (007111358612). If 
a full number is entered this customer is displayed even if the company number 
is recognized. 

Selected 

Recognizes a customer by the company number. If the number matches the 
beginning of a company number the respective company is displayed as 
customer.  

Not selected 

Recognizes a customer by his full number.  
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Valid for the type Email 

You can e.g. enter a company email address (e.g. comergo.com) and in addition 
enter individual employees with their full email addresses e.g. (heinz.schmidt@ 
comergo.com). If a full email address is entered this customer is displayed even 
if the company email address is recognized. 

The characters after the @ are usually used for a company email address.  

Selected 

Recognizes a customer by the company email address. If the email address 
matches the company email address the respective company is displayed as 
customer.  

Not selected 

Recognizes a customer by his full email address.  

Numbers/emails 
A list shows the numbers and emails addresses that can be used to identify a 
customer. The following information is listed.  

• Type 

• Category 

• Number or email 

You can create, edit or delete an entry.  

Personal contact/topic 
A list shows the personal contacts and topics.  

The following information is listed.  

• Name (of agents or topics) 

• Telephone number 

• Email 

• Dialed topic 

You can insert or delete personal contacts (agents) or personal topics.  
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Creating or changing a customer number or 
email 
A customer number can have 128 digits maximum. 

You can select type and kind of number. 

You can select one of the following types. 

• Telephone 

• Fax 

• Email 

You can select one of the following kinds. 

• Office 

• Mobile 

• Private 

Inserting an agent as personal contact 
If you click the Insert agents button in the Customer-Edit dialog, the Select 
personal contact for customer dialog opens.  

A list shows the agents with name, task type, number and PBX.  

If you select a PBX and task type the list shows only matching entries.  

Inserting a topic as personal topic 
If you click the Insert topics button in the Customer-Edit dialog, the Select 
personal topic for customer dialog opens.  

A list shows the topics with name, task type, number and PBX.  

If you select a PBX and task type the list shows only matching entries.  

Dialed topic 
In the Edit customer dialog, if you select a contact and click Dialed topic, the 
Assign topic dialog opens 

A list shows the topics with name, task type, number and PBX.  

If you select a PBX and task type the list shows only matching entries.  
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Importing customers 
You can import customer data.. You need two files for the import. One file 
(import file) contains the data records. The other file (control file) is used to 
control the import.  

You can select whether the imported data is to replace the existing customer data 
or whether it is added to the existing data. 

Which prerequisites must be met? 
The following prerequisites must be met if you want to import customers.  

• The name of the import file must be the same as the name of the 
control file. The only difference is the file extension.  

• Both files must be in the same folder. 

Restriction 
You can only import agents.  

What does an import file look like? 
The import file contains the data records.  

The data of a record is separated with semicolons (;).  

You must not use any other characters (e.g. ").  

The file extension is csv. 

What does a control file look like? 
The control file contains the entries necessary for controlling the import.  

The entries of the control file must match the entries of the import file.  

The file extension is txt. 
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Permitted settings for the control file 

The following settings may be used for a control file. You cannot use other 
settings. The entry is case-sensitive.  

Settings Default Must 
use 
setting 

Max. 
record 
length 

Comment 

NOP - - Any NOP signifies that this 
column of the record is not 
imported.  

Name - Yes 19 Name of customer 

Prio 1 No 1 Priority 

IsCompany 1 No 1 Specifies if the entry is a 
company address. 

CustomerNo - No 19 Customer number 

AgentNumber  No 29 Agent's number 

Agent - No 29 Agent's name. You can 
import several personal 
contacts (agents).  

TopicNumber - No 29 Number of a topic 

Topic - No 29 Name of a topic 

BusinessPhone - Yes 128 Customer's business number 

BusinessEmail - No 128 Customer's business email 
address 

BusinessFax - No 128 Customers business fax 
number 

PrivatePhone - No 128 Customer's home number 

PrivateEmail - No 128 Customer's home email 
address 

PrivateFax - No 128 Customer's home fax 
number 

MobilePhone - No 128 Customer's mobile number 

MobileEmail - No 128 Customer's mobile email 
address 

MobileFax - No 128 Customer's mobile fax 
number 

PhoneNumber - Yes 128 Old setting for 
BusinessPhone 
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You have to enter 0 or 1 for the entries Prio and IsBusiness. If you do not enter 
values, 1 is set for Prio and IsBusiness (selected). Fields that are not configured 
are left empty. Make sure that the name of the agent used as personal contact is 
the same name used by the IP Office Contact Center system. If this is not the 
case the personal contact is not imported. 

Examples for data and control files 
The following texts are examples for an import and the corresponding control 
file. In the example, only the data Name, CustomerNo and personal contact 
(Agent) are imported from the import file. 

File name of the import file: Example.csv 

Import GmbH;Stuttgart;0815;0711/4722;imports all;Agent_5 

Export GmbH;Munich;0207;089/4712;exports all;Agent_3 

Polzer Peter;Frankfurt;0816;069/4713;Developer;Agent1 

File name of the control file: Example.txt 

Name 

NOP 

CustomerNo 

BusinessPhone 

NOP 

Agent 
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Importing customer data automatically 
You can import customer data automatically. The Configuration module 
imports the customer data automatically at set intervals.  

Prerequisites 
The following prerequisites must be met if you want to import customers.  

• The name of the import file must be the same as the name of the 
control file. The only difference is the file extension.  

• Both files must be in the same folder. 

What can you configure? 
You can configure the following settings for automatic import.  

Setting Explanation 

Automatism enabled Check this box to enable the automatic import of 
customer data.  

Import file Select an import file.  

Ignore import errors If you check this box the Configuration module ignores 
errors during import.  

Mode You can select a mode: 

Replace existing customer data 

For the automatic import the Configuration module first 
deletes all existing customer data. The customer data is 
newly created with the import.  

Add imported customer data to existing data 

The existing customer data is updated. If customer data 
with the same number is imported the existing data is 
overwritten.  

Time You can select the following intervals for the automatic 
import. 

The import starts every day at the time set. 

The import starts every week at the weekday and time 
set. 

The import starts at the time specified.  

Use the format hh:mm (hours:minutes) for times.  

Icon for automatic import 
If automatic import is enabled, a clock icon is displayed at the right of the status 
bar.  
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Configuring external 
destinations 

What is an external destination? 
Any external number (e.g. a mobile telephone number) or the VDN of another 
call center can be an external destination.  

You use external destinations in the Taskflow Editor.  

What does the External destination tab show? 
The External destination tab lists all configured external destinations. The list 
shows the following information. 

Header Explanation 

Name Shows the name of the external destination. 

Task type Shows the task type of the external destination.  

Number/email Shows the number or email address of the external 
destination. 

How many external destinations can you 
configure? 
You can configure any number of external destinations.  

Which actions can you execute with the External 
destination tab? 
You can execute the following actions with the External destination tab. There 
is a button for each action.  

Action Explanation 

Editing Opens the selected external destination. You can edit the 
properties.  

Create Creates a new external destination.  

Copy Copies the selected external destination.  

Delete Deletes the selected external destination.  
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Properties of an external destination 
You can configure the properties of an external destination.  

You can set up an external destination to be able to forward a message as an 
SMS or fax or print the message on a network printer.  

Properties 
You must define the following properties for external destinations.  

Property Explanation 

Name Shows the name of an external destination. You can use 
29 alphanumeric characters maximum. 

No brackets ( ) [ ] { } 
Please note that you must not use any brackets for the 
name of an object.  

No characters @ " ' % ! \ < > | / ? = 

Please note that you must not use these characters for the 
name of an object. 

Task type Shows the task type of an external destination.  

You have to enter the number and the delay time if 
destination is busy for the task type Telephony. 

You have to enter the email address for the task type 
Email.  

Telephone number 

Task type:  
 Telephony 

Shows the number of the external destination. You can 
use 25 digits maximum. You have to take the access code 
into account for external destinations.  

The number is obligatory for the task type Telephony. 

Email 

Task type:  
 Email 

Shows the email address of the external destination. You 
can use up to 25 characters.  

The email address is obligatory for the task type Email.  

You can define an external destination as an SMS, fax or 
network printer. In the Email field, use the following 
entries.  
Email address EMAIL=<email address> 

SMS=<telephone number> 

FAX=<telephone number> 

PRINT=<UNC path to the network printer> 

Delay time if 
destination is busy 

You can only enter the delay time if dest. busy for the 
task type Telephony.  

Shows the delay time in minutes and seconds. The 
minimum delay time is one second, the maximum delay 
time 1 hour.  

The delay time defines for how long the external 
destination is blocked for task flow processing. Please 
note that the delay time is not equivalent with automatic 
redialing. 

Variables Shows the defined variables. 
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How does the delay time work? 
A delay time of 1 minute is set for an external destination. Task flow processing 
tries to route to this external destination. The external destination is busy. It is 
now blocked for task flow processing for 1 minute. During this time (delay time) 
the task flow processing does not try to reach the destination. After the delay 
time, 1 minute in this example, task flow processing tries to reach the destination 
again.  

 

Configuring voice recording 
with Voicemail Pro 

You can configure voice recording to occur automatically or on demand  

Configuring automatic voice recording 
Automatice voice recording occurs when an agent connects to an incoming call 
with the topic variable VMProRec assigned.  

Announcements and queries with voice control scripts are not recorded. Calls of 
less that three seconds duration are not recorded. Voice recording ends when the 
agent transfers the call or when the agent or caller ends the call.  

Voice recording is paused for consultation call and resumes when the 
consultation call ends. Voice recording is paused for calls on hold. 

Procedure 
1. Configure a voice recording tag. Select Administration > 

Configuration > Tag list > Create. 

2. In the Tag - Create window, in the Name field, enter VMProRec. 

3. In the Data Type field, select Number. 

4. In the Resolution field, select Integer. 

5. Assign the tag as a topic variable. Select Administration > 
Configuration > Topic > <topic_name> > Variables > Add > Select 
Tag. 

6. In the Select Tag window, select the VMProRec tag and then select the 
value. The value options are: 

• 0: Tag is not appled to the topic and no automatic recording occurs. 

• 1:  Call is recorded when agent connects and the Recording Type is 
VRL. 
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• 2: Call is recorded when agent connects and the Recording Type is 
VRLA. 

• <xxxx>: Call is recorded when agent connects and the Recording 
Type is any valid IP Office Mailbox number. 

Configuring on demand voice recording 
When on demand voice recording is configured, an agent can select the 
recording button to initate voice recording. The call can be incoming or outgoing 
and can be a distributed call or a direct call. If an announcement is configured in 
Voicemail Pro, recording starts after the announcement. 

The recording button light is green when voice recording is active. The agent can 
toggle voice recording on and off. Each time voice recording is initated, a new 
file is created. 

Announcements and queries with voice control scripts are not recorded. Calls of 
less that three seconds duration are not recorded. Voice recording ends when the 
agent transfers the call or when the agent or caller ends the call.  

Voice recording is paused for consultation call and resumes when the 
consultation call ends. Voice recording is paused for calls on hold. 

Procedure 
1. Configure an External Destination. Select Administration > 

Configuration > External Destination. 

2. In the External Destination - Edit window, enter the external destination 
Name. 
The Name must begin with VMProRec. You can configure as many 
external destinations as required for different recording types and 
destinations. For each external destination, append the number to the 
name. For example, VMProRec3100. 

3. Enter a value in the Number field. The options are: 

• 0: Tag is not appled to the topic and no automatic recording occurs. 

• 1:  Call is recorded when agent connects and the Recording Type is 
VRL. 

• 2: Call is recorded when agent connects and the Recording Type is 
VRLA. 

• <xxxx>: Call is recorded when agent connects and the Recording 
Type is any valid IP Office Mailbox number. 

4. Assign the external destination to the recording button. Select 
Administration > UI config > Agent > <agent> > Contact bar. 

5. In the Configuration Contact Bar window, if the Default check box is 
checked, uncheck it. 

6. In the Available elements list, select the Recording element and click 
Add to move it to the Selected elements list. 

7. In the call recording on: (element: recording) field, click the selection 
button. 

8. In the Choose external destination window, select the external 
destination. 

9. Click OK. 

10. Close the Configuration Contact Bar window. 
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Configuring workplaces 

What is a workplace? 
A workplace lets you assign a PC and telephone to a specific workstation.  

When an agent logs in on the IP Office Contact Center system with a PC and 
Outlook, the PC is automatically listed in the list of workplaces. The host name 
of the PC is used as name. You can change the name and assign a telephone to 
the workplace.  

What does the Workplace tab show? 
The Workplace tab lists all configured workplaces. The list shows the following 
information. 

Header Explanation 

Name Shows the name of the workplace.  

 

Terminal workplace Shows the name of the terminal workplace.  

Type Shows the type of terminal workplace.  
PC for personal computer. 
NC for network computer.  

Telephone Shows the number of the telephone.  

PBX Shows the PBX the telephone is connected to.  

How many workplaces can you configure? 
You can configure any number of workplaces.  
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Which actions can you execute with the 
Workplace tab? 
You can execute the following functions with the Workplace tab. There is a 
button for each action.  

Action Explanation 

Editing Opens the selected workplace. You can edit the 
properties. 

Create Creates a new workplace.  

Copy Copies the selected workplace.  

Delete Deletes the selected workplace.  

 

Editing a workplace 
You can configure the properties of a workplace.  

You can configure a terminal workplace and telephone for a workplace.  

Workplace name and info 
You can enter a name and info for a workplace.  

The name must be unique in the IP Office Contact Center system. You can use 
256 alphanumeric characters maximum.  

In addition to the name of a workplace you can enter information. You can use 
256 alphanumeric characters maximum.  

Terminal workplace 
You can enter the following information for a terminal .  

 

Information Meaning 

Type Specifies the type of terminal workplace. You can select PC or 
NC.  

PC for personal computer. 

NC for network computer. 

Type: PC 

Host name 

If you select PC, specify the host name of the terminal 
workplace.  

Type: NC 

NC name 

If you select NC, specify the network computer name of the 
terminal workplace. You must enter the network computer 
name in all capital letters.  

About Shows information on the terminal workplace. You can use 
256 alphanumeric characters maximum.  

Telephone 
If you configure a telephone as a workplace you must  enter the number and 
select a PBX.  
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Telephone messaging 

By default, IP Office Contact Center message feedback on the phone is switched 
off. It can be switched on by setting a configuration variable on the pbx. The 
variable must be created from TaskTag in configuration. The name of the 
TaskTag must be "IPOSendPhoneMsg". Type is a string. Once the TaskTag is 
created, it can be assigned to the PBX and the value can be set. 

When the value is set to "on" IP Office Contact Center phone messaging is 
activated. When the value is set to "off" or variable is not set, phone messaging 
is not activated. 

Note that the set value for the "IPOSendPhoneMsg" tasktag is case sensitive. 
Only lower case "on" or "off" is accepted. 

How do you set up an agent on a terminal server? 
To set up an agent on a terminal server, follow these instructions.  

Installing on a terminal server 
You must install the user interface as an RPC connection on the terminal server.  

An agent on a PC starts a terminal server session on a terminal server. A 
telephone is assigned to the agent. 

Setting up a workplace on a terminal server 
To set up a workplace as a terminal server, follow these steps.  

1. Click the Workplace tab.  

2. Click Create. The Workplace Configuration - Create dialog 
opens.  

3. Enter a name. You can enter information as an option.  

4. Select  Terminal workplace.  

5. Select  NC.  

6. Enter the NC name in all caps. You can enter information as an 
option. 

7. Select a telephone.  

8. Click OK to save your settings. The workplace is set up and 
appears in the list.  

Signing on 
Note that each remote client is signed on with its own separate account. If this is 
not the case, the different client sessions and accounts logged on to the terminal 
server can influence each other.  

Effect 1:  
testuser is signed on to the terminal server. testuser is also signed on to the 
remote client. If the user interface is started on the remote client, it also starts on 
the terminal server.  

Effect 2:  

If the same remote account is signed on to multiple terminal sessions, starting 
the user interface on one terminal client also starts the client on all corresponding 
terminal sessions.  
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Note for trace system 
If you use the trace system (TTrace), you can use the following function.  

1. You have activated the ReportRPCFunction reporter category in 
the kernel.  

2. A remote client name is displayed in the trace system output.  
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Configuring pause codes 

What is a pause code? 
You specify the kind of break with a pause code.  

What does the Pause code tab show? 
The Pause code tab lists all configured pause codes. The list shows the 
following information. 

Header Explanation 

Name Shows the name of the pause code.  

How many pause codes can you configure? 
You can configure any number of pause codes.  

Which actions can you execute with the Pause 
code tab? 
You can execute the following actions with the Pause code tab. There is a button 
for each action.  

Action Explanation 

Editing Opens the selected pause code. You can edit the 
properties. 

Create Creates a new pause code.  

Delete Deletes the selected pause code.  

Editing a pause code 
You edit the properties of a pause code with the Pause Code dialog.  

Pause code 
Shows the name of the pause code. You can use 254 alphanumeric characters 
maximum. 
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Configuring PBXs 

What is a PBX? 
PBX stands for private branch exchange.  

What does the PBX tab show? 
The PBX tab lists all configured PBXs. The list shows the following 
information. 

Header Explanation 

Name Shows the name of the PBX.  

Abbreviation Shows the abbreviation of the PBX.  

Location Shows the location of the PBX.  

Type Shows the type of PBX.  

Version Shows the version of the PBX.  

How many PBXs can you configure? 
You can configure any number of PBXs.  

Which actions can you execute with the PBX 
tab? 
You can execute the following actions with the PBX tab. There is a button for 
each action.  

Action Explanation 

Editing Opens the selected PBX. You can edit the properties. 

Create Creates a new PBX.  

Delete Deletes the selected PBX.  

If you delete a PBX, all assigned agents, topics, agent 
groups, voice units, announcements, announcement 
scripts, telephones and queue devices are also deleted.  

Editing a PBX 
You can configure PBX properties, accesses and connections. You can view the 
PBX settings.  
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Editing a PBX configuration 
You can configure the following properties of a PBX.  

General fields 

You enter the following settings as general settings for a PBX.  

 
Setting Explanation 

Name Shows the name of the PBX. This name must be unique 
within the IP Office Contact Center system.  

Abbreviation Shows the abbreviation of the PBX. This setting is 
optional. 

Location Shows the location of the PBX. This specification is 
optional.  

Color Shows the color of the PBX. The PBX is displayed with 
this color by the modules of the IP Office Contact Center 
system.  

Type Shows the type of PBX.  

Version Shows the software version of the PBX. The kernel 
process needs this information.  

 

User name 

Password 

IP Office 

Not required.  

List 
The PBX connections are listed. You have to enter the corresponding properties 
for more than one PBX.  
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Assign to IP Office Contact Center 

Selecting this option activates the input boxes for IP Office Contact Center.  

 
Setting Explanation 

Access code for 
dialer 

Shows the access code for external connections for 
Preview, Direct and Agent dialers.  

The external line code is a special code used within 
PBXs for seizing external lines and for numbers of dialer 
campaigns. If this code is prefixed it allows the seizure of 
specific lines.  

The numbers of campaigns do not have to be adjusted.  

Additional note 

For the dial parameters of a campaign or topic the option 
Mark call as ACD call must not be selected or the 
external line code is not used.  

Access code for 
external OutCC 

Shows the access code for external callback.  

Access code for 
internal OutCC 

Shows the access code for internal callback.  

Access code You must enter an access code  for Preview, Direct and 
Agent dialers. You can configure any number of access 
codes.  

You can insert, change or delete access codes for 
preview, direct and agent dialers.  

Access code for 
address book server 

Shows the access code for address book server. The 
address book is used by agents as telephone book 
function.  
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Settings 
The settings of the configured PBX are listed.  

The list shows the following information with description, minimum and 
maximum values.  

• Number of AGs per agent 

• Number of overflow groups 

• Length password 

• Number of B-channels 

• Length topic name 

• Length AG name 

• Length agent name 

• Dealer group 

• Urgent info (agent) 

• Signaling threshold (agent) 

• Announcement text number 

• AG position 

• AG priority 

• Job code length general 

• Job code length for topic 

• Ring timeout (AG) 

• ACW agent 

• ACW topic 

• Announcement factor (AG) 

• Overflow factor (AG) 

• Queue factor (AG) 

• AG number 
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External line 
The External line dialog shows a list of all configured external lines. 

Which actions can you execute with the External line tab? 
You can execute the following actions with the External line tab. There is a 
button for each action.  

Action Explanation 

Cancel Cancels an action. 

Create Creates a new external line.  

Delete Deletes the selected external line. 

What does the external line list include? 

The list shows the following information. 

Header Explanation 

Country setting Shows the selected country. 

Area code Shows the area code. Example: 07191 

PBX number start Shows the PBX start number.  
Example: 13586-00 

PBX number stop Shows the PBX stop number.  
Example: 13586-99 

Number of local 
digits 

Shows the number of local digits (digits which already 
belong to the local call number stock of the PABX 
domain.  

Example:  

PABX number start 1321 to PABX number end 1385 

Therefore there are 2 local digits.  

If you only enter one PABX number start the number of 
local digits is 0.  

Creating an external line 

To create an external line, follow these steps. 

1. In the External line list, view click the Create button. The Country 
setting field is set to Germany by default.  

2. In the Area code field, enter the area code. 

3. Fill in the PBX number start, PBX number stop and Number of 
local digits fields. 

4. Click OK to confirm your settings. 

Deleting an external line 

In the External line list, select one or more country settings and click the Delete 
button. The selected external lines are deleted following a prompt.  
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Configuring PBX connections 
You have to configure the connections of the PBX. You must configure inbound 
and outbound connections.  

From PBX 1 to PBX 2 

Access code 

Shows the access code from PBX 1 to PBX 2. 

Number 

Shows the number of B-channels from PBX 1 to PBX 2. 

From PBX 2 to PBX 1 

Access code 

Shows the access code from PBX 2 to PBX 1. 

Number 

Shows the number of B-channels from PBX 2 to PBX 1. 
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Task server 
The Task server dialog lets you edit and display the general properties of a task 
server.  

Displays 
1. To edit the properties of a task server, click Edit. The following 

properties are shown on three tabs. 

General tab 

Enter the following settings as general settings for a task server.  

 

Setting Explanation 

Name Shows the name of the task server. 

Host name Shows the network computer name of the task server. 

Session ID Shows the session ID of the task server. If multiple 
task servers are connected to the PBX, the session ID 
is different. You cannot edit this value.  

Start time Specifies the time when the task server is started. You 
cannot edit this value.  

Version Shows the current version of the task server. You 
cannot edit this value.  

Properties tab 
The Properties tab shows following information.  

 

Setting Explanation 
PABXTenant The PABXTenant is used for the configuration 

synchronization with the PBX. You can enter multiple 
tenants. The Tenants are separated by a comma. If you 
change a tenant, the configuration will be updated.  

PbxDriverName Specifies the name of the PBX task server.  
EndPauseAfterLogin false 

Default. The pause is not finished after logging. 
true 
The pause is terminated after logging. 

 

The Assignment tab displays the content of the task server. 

Setting Explanation 
Assigned applications Shows the assigned applications. In general 

[VEA] VEA must be assigned in the list. 
You can edit the properties of an assigned 
application.  
See also: Editing the properties of an 
assigned application. 

Other applications Shows the other applications.  
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Editing the properties of an assigned application 
[VEA] VEA 
You can edit the properties of an assigned application.  

General tab 

Enter the following settings as general settings for an assigned application.  

 

Setting Explanation 

Name Shows the name of the application. 

Host name Shows the network computer name of the application. 
You cannot edit this value. 

Session ID Shows the session ID of the application. You cannot 
edit this value.  

Start time Specifies the time when the application is started. 
You cannot edit this value.  

Version Shows the current version of the application. You 
cannot edit this value.  

 

Properties tab 

Enter the following settings as properties for an assigned application.  

 

Setting Explanation 

UseCarrierBasedRouting The UseCarrierBasedRouting parameter 
must be set (true) if calls that cannot be 
routed in the IP Office Contact Center 
system must be further routed in the 
intelligent network.  

If the UseCarrierBasedRouting 
parameter is not set (false), the caller 
immediately hears a dial tone.  

The default setting is false.  

DefaultScript Do not change the setting.  

MaxTransferTime Do not change the setting. 

TaskserverActionTimeout Do not change the setting. 

TaskServerRouteResponseTimeout Do not change the setting. 

MaxSpeakTime Do not change the setting. 
MaxCountOfWaitQueueDevices Shows the percentage of devices 

available used for queue devices.  

MaxCountOfDialingDevices Shows the percentage of devices 
available for the dialer used for outbound 
jobs.  

DisconnectSupervisonTimeout Do not change the setting. 

PlayTextSeqRetryTimeout Do not change the setting.  

PlayTextSeqRetryCount Do not change the setting. 
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Settings for dialers with IP Office Contact Center 

You must set MaxCountofWaitQueueDevices and 
MaxCountofDialingDevices for using the Dialer module with IP Office Contact 
Center.  

You can configure the values to total more than 100%. For example, you can set 
75% for queue devices and 65% for dialing devices. This enables optimum use 
of the devices for inbound and outbound calls and jobs. If you have few inbound 
calls for example, the Dialer module can use more devices for outbound jobs or 
vice versa if you have more inbound calls.  

Do not set MaxCountofDialingDevices too high since otherwise there may be 
no available devices for inbound calls, which are then routed to the queue.  

See also: Using the Dialer module with IP Office Contact Center. 
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PBX access 
The PBX Access dialog shows a list of connections with the PBX. 

You can use several Module Managers on different PCs for accessing a PBX. 
You have to configure these connections with the PBX accordingly.  

Which actions can you execute with the PBX Access dialog? 

You can execute the following actions with the PBX Access dialog. There is a 
button for each action.  

Action Explanation 

Insert Creates a new PBX access. You can edit the properties. 

Delete Deletes the selected PBX access.  

Editing a PBX access 

You have to enter host name, port and B-channels for PBX access.  

Setting Explanation 

explanation 

Explanation 

L0x 

Host name Shows the name or TCP/IP 
number of the PC the Module 
Manager is installed on.  

You have to enter the TCP/IP 
number of the ACB board. The 
PBX with L0x must be 
accessible in the network.  

Port Shows the socket port of the 
respective Module Manager. 
This is usually socket port 
5679. 

Shows the socket port for 
accessing the PBX with L0x. 
You must enter port 6555.  

B-channels 

 

Shows the number of B-
channels of the respective 
Module Manager. One B-
channel is usually used. A 
changed number of B-channels 
becomes effective only after a 
reconnect with the PBX (PBX 
is deactivated and reactivated).  

Multiple LAN connections for 
a multi-module PBX are 
possible.  
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Access code 
You must enter an access code  for Preview, Direct and Agent dialers. You can 
configure any number of access codes.  

You can insert, change or delete access codes for Preview, Direct and Agent 
dialers.  
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Conf. access 
The dialogue is currently without function.  

OSSI stands for Operations Support Systems Interface.  

From the CM configuration the agent passwords are read and transferred in the 
IP Office Contact Center system over a synchronisation.  

For the function a user for OSSI with appropriate authorization is needed. You 
must configure the access to OSSI.  

Enter the following settings.  

 

Setting Explanation 

IP address Specifies the IP address of the CM.  

Port Specifies the port for the connection to OSSI. The 
default port is 5022. 

User Specifies the OSSI user. You can use 29 
alphanumeric characters maximum. 

Password Specifies the password of the user. You can use 29 
alphanumeric characters maximum. 

2nd password (opt.) Specifies an optional password. You can use 29 
alphanumeric characters maximum. 

Pin (opt.) Specifies an optional PIN. You can use 20 numbers 
maximum. 

Automatic 
synchronisation 

You can select that the data are synchronized 
automatically. The data are read in the OSSI and 
transferred to the IP Office Contact Center. In the 
OSSI no data are changed.  

Start time You can set a time for the automatic synchronisation. 
Adjustable is 00:00 to 24:00. 

Interval You can enter an interval between 30 minutes and 30 
days. If you enter 0, then the synchronisation will be 
done only once at the start time. 

Messages 
Messages about the function are shown in the trace outputs of the process config.  
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Usage 
A IP Office Contact Center system can use CM agents.  

To use a CM agent in the IP Office Contact Center system, you have to enter the 
phone number configured in the CM in the IP Office Contact Center telephony 
configuration. The PBX process task server then uses the corresponding CM-
Agent.  

Configuration- Agent – tab Telephony - Number 

CM agent password 
The CM-Agent has for logging on the telephone a CM agent password. The CM 
agent password can be included in the following ways in the IP Office Contact 
Center configuration:  

• Submit CM Agent password in the application configuration 

• Submit CM agent password by the IP Office Contact Center agent 
in user interface 

• Submit CM agent password by the process IP Office Contact 
Center Config 

In all three variants it is important to note that the IP Office Contact Center 
system does not write data to the CM. The CM agent password is encrypted in 
the IP Office Contact Center database. The CM-Agent password is used when 
logging the CM agent on the phone by the IP Office Contact Center UI. 

Submit CM Agent password in the application configuration 
A IP Office Contact Center administrator can add a current CM-agent password 
for the  agent.  

Submit CM agent password by the agent in user interface 
The IP Office Contact Center administrator does not know all the CM agent 
passwords. The IP Office Contact Center agent can enters the CM agent 
password. If the IP Office Contact Center agent has entered the correct CM-
agent password, then the CM Agent are logged on automatically by the IP Office 
Contact Center-UI.  

User Interface - File- Change PBX password 

Submit CM agent password by the process IP Office Contact Center  
Config 
The IP Office Contact Center Config process can use the Operations Support 
System Interface (OSSI) of the CM. The CM-Agent password is read and stored 
in the IP Office Contact Center database. For this function, the following 
requirements must be set:  

• Access to the OSSI of the CM must be configured in the IP Office 
Contact CenterUI. 

• The used OSSI Users (init) must be authorized to read the CM 
agent passwords. 

If these conditions are met, then the process IP Office Contact Center Config 
reads for agents who have configured in the tab telephony a CM agent number, 
the corresponding CM-agent passwords from the CM and enters it in the IP 
Office Contact Center database.  

The adjustment is using the following conditions.  

• The OSSI access is configured on the PBX system and activated. 

• The OSSI data have the required permission level. 

• The process IP Office Contact Center Config is started.  
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• The IP Office Contact Center-Config process is working and the 
OSSI password will be changed in the IP Office Contact Center-
config UI. 

• The IP Office Contact Center-Config process is working and an 
interval is entered. The interval determines when the data are 
imported.  

Configuring the country setting 

What is the country setting? 
The country setting lets you enter the name of a network provider, assign it a 
country and enter the national and international codes. The country setting 
displays the provider data.  

What does the Country setting tab show? 
The Country setting tab lists all configured countries. The list shows the 
following information.  

Header Explanation 

Name Shows the name of a network provider (such as 
Deutsche Telecom AG, Arcor).  

Country Shows the country name of the country setting. 

Country code Shows the country code (for example, 49 for 
Germany, 33 for France, 39 for Italy). 

National code Shows the national code for the country setting 
(example: 0). 

International code Shows the international code for the country setting 
(example: 00). 

Use area code Indicates whether the area code for the country setting 
is also dialed. (For example, in Spain you always dial 
the area code) 

 

Which actions can you execute with the Country 
setting tab? 
You can execute the following actions with the Country setting tab. There is a 
button for each action.  

Action Explanation 

Editing Opens the selected country setting. You can edit the 



 

146  •  Configuring the country setting Using IP Office Contact Center  Configuration Tool 

Action Explanation 
properties. 

Create Creates a new country setting.  

Delete Deletes one or more selected country settings.  

Editing the country setting 
Double-click the country you want to change or click the Edit button to open the 
Country setting - Edit dialog. You can edit the settings. 

Creating a country setting 
To create a country setting, follow these steps. 

2. On the Country setting tab, click the Create button. The Create 
country setting dialog opens.  

3. In the Name field, enter a network operator. 

4. In the Country field, enter a country. 

5. Fill in the Country code and Codes fields and select the Use area 
code checkbox. 

6. Click OK to confirm your settings. 

Deleting a country setting 
To delete a country setting, follow these steps. Please note that you cannot undo 
this action.  

7. On the Country setting tab, select one or more country settings 
and click the Delete button. You are prompted. 

8. Click Yes. The selected country settings are deleted.  
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Configuring queue devices 

What is a queue device? 
A queue device receives incoming calls until they can be forwarded to an 
available agent. 

What does the Queue device tab show? 
The Queue device tab shows a list of start and stop numbers and the associated 
PBX. The list shows the following information. 

Header Explanation 

Number Shows the queue device number. 

PBX Shows the PBX for the number. 

active Symbol X indicates that the number has been set up in 
the CHAP configuration.  

Which actions can you execute with the Queue 
device tab? 
You can execute the following actions on the Queue device tab. There is a 
button for each action.  

Action Explanation 

Create Creates a new number block.  

Delete Deletes one or more selected numbers.  
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Editing queue devices 
The Queue device tab displays the assigned numbers and PBX. These numbers 
are used for the PBX to assign the queue devices. 

Creating queue devices 
If you use queues, you must configure queue devices. Proceed as follows: 

1. On the Queue device tab, click the Create button. 

2. Select a PBX. The Create queue device dialog opens. 

3. In the Start no. field, enter the first number. 

4. Click the Stop no. field. The number entered in the Start no. field is 
highlighted. Replace this number with the stop number and click OK. 

Deleting queue devices 
To delete a queue device, follow these steps. Please note that you cannot undo 
this action.  

1. On the Queue device tab, select one or more numbers and click the 
Delete button. You are prompted.  

2. Click Yes. The selected numbers are deleted.  
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Configuring telephones 

What is a telephone? 
The Telephone tab lets you specify the available agent telephones for the IP 
Office Contact Center. The ACM PBX and IP Office Contact Center system are 
not synchronized automatically.  

Notice IP Office PBX 
For each telephone configured in the IP Office Contact Center system, a AES 
license VALUE_TSAPI_USERS is allocated.  

What does the Telephone tab show? 
The Telephone tab lists all configured numbers and PBXs. The list shows the 
following information. 

Header Explanation 

Subscriber number Shows the number of the telephone. 

PBX Shows the PBX for the number. 

Name Shows the configured name. The name can be used in 
the realtime information Telephone status for 
telephone group (grid).  

IP address Shows the IP address of the telephone.  

MAC address Shows the MAC address of the telephone.  

Last contact to push_srv Shows the time of the last contact to the push server.  

Which actions can you execute with the 
Telephone tab? 
You can execute the following actions with the Telephone tab. There is a button 
for each action.  

Action Explanation 

Create Creates a new number block. 

Delete Deletes one or more selected numbers. 
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Editing telephones 
The Telephone tab displays the assigned numbers and PBX. 

Creating a telephone 
To create a telephone, follow these steps. 

1. On the Telephone tab, click the Create button. 

2. Select a PBX. The Create telephone dialog opens. 

3. In the Start no. field, enter the first number. 

4. Click the Stop no. field. The number entered in the Start no. field is 
highlighted. Replace this number with the stop number and click OK. 

Deleting a telephone 
To delete a telephone, follow these steps. Please note that you cannot undo this 
action.  

1. On the Telephone tab, select one or more numbers and click the 
Delete button. You are prompted.  

2. Click Yes. The selected numbers are deleted. 
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Configuring telephone groups 

What is a Telephone group? 
You can usa a telephone group to get real time informations about it.  

Conditions 
To configurations a telephone group you need the following conditions.  

• You need the privilege of telephone / telephone group. 

• You need the appropriate permissions for the telephones and 
telephone groups.  

What does the telephone group tab show? 
The Register-phone group shows the name of the phone-groups. 

Name 

You can use 29 alphanumeric characters maximum. The name must be unique in 
the IP Office Contact Center system.  

Number of Telephone groups 

The number of telephone groups is not limited.  

Which actions can you execute with the Telephone 
group tab? 

You can execute the following actions with the Telephone group tab.  

Action Explanation 

Edit Opens a selected telephone group. You can edit the 
properties.  

Create Creates a new telephone group.  

Copy Copy a selected telephone group.  

Delete Deletes a selected telephone group.  
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Monitoring telephone status 
1. You can monitor individual telephone or telephone group status. A 

telephone group can contain all employees within a single 
department.Configure the real-time information file. 

a. Add a monitor Telephone status for the group. 

b. To call a telephone, you can set the Call with double-click 
property. 

c. Save the information file. 

2. View the telephone status. 

Each telephone in the group appears as a button. The button color 
indicates the telephone’s status. The display shows the telephone 
number. If an agent is logged in, the tool tip displays the agent’s name. 

3. Double-click a telephone button to call the agent. 

 

Configuring the CHAP server 

What is the CHAP server? 
CHAP stands for Common Hardware Abstraction Platform. 

What does the CHAP server tab show? 
The CHAP server tab lists all known CHAP servers and host names. The list 
shows the following information.  

 

Header Explanation 

Name Shows the name of the CHAP server. 

Host name Shows the network computer name of the CHAP 
server. 

Session-ID Shows the session ID of the CHAP server if more 
than one CHAP server is connected to the PBX. The 
session ID is always displays and is different for 
different CHAP servers. 

Start time Specifies the time when the CHAP server is started. 

Version Shows the current version of the CHAP server. 
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Which actions can you execute with the CHAP 
server tab? 
You can execute the following actions with the CHAP server tab.  

Action Explanation 

Editing Opens a selected CHAP server. You can edit the 
properties.  

Insert Inserts a new CHAP server.  

Delete Deletes a selected CHAP server.  
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Editing the CHAP server 
The Edit CHAP dialog lets you configure the CHAP server.  

Prerequisite 
To edit the CHAP, the VEA and CHAP Sync processes must be running.  

Properties Chap adapter line 
You must configure the following properties for the Chap adapter line. A 
plausibility check will be done. You will become a message in case of error.  

Pool for topics 
All the channels are used for topics. If you set up a channel for a phone number 
(topic), then the entire pool is used, that means all configured channels for topics 
are used. For a call number, you must set up at least one channel.  

Note that the pool function only applies to topics. The total number of channels 
is checked by the user interface. 

IPO-SIPEXT-IP Settings Explanation 
You must configure the following properties for a CHAP adapter line. The 
settings are checked for plausibility. If an error occurs, you receive a message.  
Settings Explanation 

DNSServerIP DNSServerIP sets the IP address of network 
domain name server. 

FullQualifiedLocalHost
N ame 

FullQualifiedLocalHostName sets the full qualified 
local hostname.  

Example: ipoccsystem.avaya.com 

This string is independent to any existing domain. 
Usually it is the hostname followed by the domain 
name defined in the IPO.  

LocalDomainName LocalDomainName sets the local unified domain 
name. It is independent to any existing domain 
name. It can be a complete new name. It must be 
the same namedefined in the IPO. This name is 
used within SIP to identify the chap system as an 
own pbx. Which name is used is up to the customer 
and its pbx network.  

Example: avaya.com 

LocalHostName LocalHostName sets the normal local hostname. 

Example: ipoccsystem 

LocalIPAddress Specifies the IP address of the server running the 
CHAP. 
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Settings Explanation 

LocalRTPPortRange Specifies the range for the ports used by the CHAP 
for the RTP connections. Ports 14000 to 15000 are 
set by default. Note that you need 4 ports per 
channel. If a port is assigned, the next available port 
is used. 

LocalSignalPort Specifies the far-end listen port of the associated 
IPO. The default setting is port 5100. 

MaxCallCountPerSecon 
d 

MaxCallCountPerSecond specifies the maximum 
amount of calls per second. All other calls will be 
crushed. 

NetworkQuality Specifies the network quality in percent. Example: 
75 (For details see Network Quality.) 

NodeNumberUCIDonM
a keCall 

NodeNumberUCIDonMakeCall specifies the node 
number which will be integrated into a CHAP 
generated UCID. In case of making a complete new 
call by IP Office Contact Center/CHAP and 
SuppressUCIDonMakeCall is switched to “false” 
this number will be part of the first 2 bytes. 

PBXDomainName PBXDomainName this name must be the same 
name as in the IPO.  

PBXIPAddress Specifies the IP address of the SIP trunk Ethernet 
connection in the IPO. (For details see 
PBXIPAddress, PBXSignalPort.) 

PBXPingPeriod Indicates the time in milliseconds between two 
pings. If you enter 0 then ping is deactivated. 
Example 3000 (For details see Network Quality.) 

PBXSignalPort Specifies the near-end listen port of the associated 
signaling group in the IPO. The default setting is 
port 5100.  
(For details see PBXIPAddress, PBXSignalPort. 

SRTP SRTP this value is recommended to set to “true”.  

SuppressUCIDonMakeC 
all 

SuppressUCIDonMakeCall switches the UCID 
generator to create UCIDs on make calls by IP 
Office Contact Center/CHAP 

TransportTypeProtocol TransportTypeProtocol default value is “TLS”. No 
other values are allowed. 

Trunk Trunk default value is “true”. No other values are 
allowed. 

 

 

PBXIPAddress, PBXSignalPort 
Within this entry it is possible to enter more than one IP address / IP port pair.  

It is a list which is used to keep working with IP Office Contact Center in case 
one PBX is down. 

Example: 

PBXIPAddress  192.168.1.10,192.168.1.20,192.168.1.30 
PBXSignalPort  5100,5200,5300 
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Each IP address corresponds to the IP port at the same position. That means: 

Position 1: 192.168.1.10 : 5100 
Position 2: 192.168.1.20 : 5200 
Position 3: 192.168.1.30 : 5300 

The list will be switched from position one to end and continues with one again 
in case one PBX is not accessible. 

This is a list of nonhierarchical PBX accesses. 

To use this feature it is necessary to configure in each PBX the same number 
ranges to guaranty full fallback. 

Network quality 
Entering PBXPingPeriod determines the network quality and compares it to the 
target network quality. When the current network quality is less than the target 
network quality, then the CHAP dismantles the IP line and activates an IP 
reconnect function. The IP reconnect function tries to reestablish the line. The 
dismantling of the IP line results in all currently active calls being dismantled in 
CHAP.  

Example:  

PBXPingPeriod: 3000 
Network Quality: 75 

The current network quality is determined over the time period of a minute with 
all the pings that took place during this period (calculated from the 
PBXPingPeriod). The number of Pings per minute is taken and set as 100%. In 
the example this is 20 pings (every 3 seconds). The minimum of the accepted 
network quality is 75%, which is 15 pings. If less than 15 pings per minute are 
successful, then the CHAP declares the IP line as severed and dismantles the line 
and tries to reestablish the IP line.  

Deleting CHAP servers 
On the CHAP server tab, select one or more CHAP servers and click the Delete 
button. The selected CHAP servers are deleted following a prompt. 
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Ring tone setup for CHAP 
You must configure the properties of the ring tone for topic calls that do not have 
announcements in the call flow. The ring tone must also be connected in CHAP, 
as this is required by QSIG.  

Ring tone properties 
You must configure the following settings for the ring tone.  
Property Example Explanation 
Name RingTone You must use RingTone.  
Frequency 425Hz Indicates the frequency in Hertz.  
Volume (75%) Specifies the volume as a percentage of the 

maximum level.  
Duration 960 ms Indicates the length of the ring tone in 

milliseconds.  
Pause 3840 ms Indicates the length of the pause following the 

ring tone in milliseconds.  

Format 
You must use the following format to specify the ring tone. You must use a 
colon (:) after the frequency. You must use a plus (+) sign between the times. 
You can press the + key several times for signal-pause times.  

Example 1: 425Hz:960ms (75%)+3840ms 

You can also specify a mixture of frequencies (two frequencies). You must 
separate the two frequency values with a forward slash (/).  

Example 2: 425/833Hz:960ms (50%)+3840ms 

Ring tone set up 
Proceed as follows to configure a ring tone.  

1. Click the CHAP server tab. The CHAP process that is started is 
displayed.  

2. Click Edit. The Chap - Edit dialog opens.  

3. Click the CHAP adapter tab.  

4. Double-click IPO-SIPEXT-IP-1. The [CHAP Adapter] - Edit 
dialog opens.  

5. Click the Properties tab.  

6. Enter the respective settings under Content. Use the specified 
format.  

7. Click OK.  

8. Click OK.  



 

158  •  Configuring the CHAP server Using IP Office Contact Center  Configuration Tool 

Examples 
The table below shows examples for a number of countries.  

Country Description RingTine value 

Germany 425 Hz tone for 1 second and 
4 seconds pause 

425Hz:1000ms + 4000ms 

United States Dual frequency tone (440 
and 480 Hz) for 2 seconds 
and 4 seconds pause 

440/480Hz:2000ms + 4000ms 

United 
Kingdom 

Dual frequency tone (400 
and 450 Hz) for 0.4 seconds, 
0.2 seconds pause, same tone 
for 0.4 seconds and 2 
seconds pause 

400/450Hz:400ms + 200ms + 
400/450Hz:400ms + 2000ms 

United States 
(reduced 
volume) 

Dual frequency tone (440 
and 480 Hz) for 2 seconds 
and 4 seconds pause 

440/480Hz:2000ms (25%) + 
4000ms 

United 
Kingdom 
(enhanced 
volume) 

Dual frequency tone (400 
and 450 Hz) for 0.4 seconds, 
0.2 seconds pause, same tone 
for 0.4 seconds and 2 
seconds pause 

400/450Hz:400ms (75%) + 
200ms + 400/450Hz:400ms 
(75%) + 2000ms 
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Fax tone detection 
You can switch on or off the fax tone detection and change the settings.  

Settings: Fax tone detection 
You must configure the following settings for the fax tone detection.  

 
Settings Explanation 

FaxToneDuration Minimum length of the fax tone in milliseconds 
before the fax tone is detected.  

Default: 120 ms.  

Range: 20 to 30000 ms.  

FaxToneThreshold Minimum amplitude height on the average over the 
before determined length of the fax tone before a 
fax tone is detected.  

Default: 300 (no unit) 

Range: 1 to 30000. 

RingTone Enter the ringtone in following format:  

40/480Hz:2000ms+4000ms 

Default:  

425Hz:960ms+3940ms for Germany 

Switch off fax tone detection 
If you indicate 0 for FaxToneDuration or for FaxToneThreshold, then the fax 
toner detection is switched off. 

Fax tone detection set up 
Proceed as follows to configure the fax tone detection.  

1. Click the CHAP server tab. The CHAP process that is started is 
displayed.  

2. Click Edit. The Chap - Edit dialog opens.  

3. Click the CHAP adapter tab.  

4. Double-click IPO-SIPEXT-IP-1. The [CHAP Adapter] - Edit 
dialog opens.  

5. Click the Properties tab.  

6. Enter the respective settings under Content.  

7. Click OK.  

8. Click OK.  
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Configuring the VEA 

What is a VEA? 
VEA stands for Voice Extension Adapter.  

Note for assigning a VEA 
You can assign a VEA one CHAP server if the host name match.  

What does the VEA tab show? 
The VEA tab lists all known Voice Extension Adaoters and host names. The list 
shows the following information.  

 

Header Explanation 

Name Shows the name of the VEA. 

Host name Shows the network computer name of the VEA. 

Session-ID Shows the session ID of the VEA.  

Start time Specifies the time when the VEA is started. 

Version Shows the current version of the VEA. 

Which actions can you execute with the VEA 
tab? 
You can execute the following actions with the VEA tab.  

Action Explanation 

Editing Opens a selected VEA. You can edit the properties.  

Insert Inserts a new VEA.  

Delete Deletes a selected VEA.  

Update Updates the display. The start time and version 
information are updated.  

Porperties VEA 
You can configure the following properties for the VEA.  
Settings Explanation 

Name Specifies the name of the Chat server.  
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Settings Explanation 

Hostname Specifies the network computer name of the VEA. 
You can use the IP address.  

SessionID An entry is not possible.  

Starttime An entry is not possible. 

Version An entry is not possible. 
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Configuring the Chat server 

What is a Chat server? 
Chat refers to an coummnication over the Internet. The information is exchanged 
in text format.  

Extensible Messaging and Presence Protocol (XMPP) is usded for the IP Office 
Contact Center Chat.  

In IP Office Contact Center you need a Chat server and a Chat taskserver.  

What dies the Chat server tab show? 
The Chat server tab listes all known Chat server with the host name. The list 
shows the following information.  

 

Header Explanation 

Name Shows the name of the Chat server.  

Hostname Shows the network computer name of the Chat server.  

Port Shows the port of the Chat server.  

Edit, create or delete a Chat server 
You can execute the following actions with the Chat server tab.   

Action Explanation 

Edit Opens a selected Chat server. You can edit the 
properties.  

Create Creates a new Chat server.  

Delete Deletes a selected Chat server. Note, that all configured 
elements (agents, topics) deleted also.  

Porperties Chat server 
You can configure the following properties for the Chat server. You can edit the 
taskserver.  
Settings Explanation 

Name Specifies the name of the Chat server.  

Hostname Specifies the network computer name of the Chat 
server. You can use the IP address.  
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Settings Explanation 

Port Specifies the port of the Chat server. Default port 5222 
is used.  

Domain Specifies the domain for Chat. 

Encoding You can select none encoding <none> or automatic 
encoding <autom.  negotiation>.  

Taskserver Specifies the name of the taskserver.  

Editing the Chat taskservers 
You can edit the properties of the Chat taskserver.  

Properties Chat taskservers 
You can configure the following properties for a Chat taskserver.  

 
Angaben Erläuterung 

Name Specifies the name of the Chat taskserver.  

Hostname Specifies the host name of the computer on which the 
taskserver is working.  

SessionID Specifies the SessionID. This information can not be 
changed.  

Start time Specifies the start time. This information can not be 
changed.  

Version Specifies the version of the Chat taskserver. This 
information can not be changed.  
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Configuring the Chat server 

What is a Chat script? 
A chat script can use for a topic, an agent and in the TaskFlow editor. The 
configured text of a chat script is sent to the chat participants automatically. The 
agent appears the text as a system message.  

What dies the Chat script tab show? 
The Chat script tab listes all Chat scripts with the name.  

Edit, create or delete a Chat script 
You can execute the following actions with the Chat script tab.   

Action Explanation 

Edit Opens a selected Chat script. You can edit the properties.  

Create Creates a new Chat script.  

Delete Deletes a selected Chat script. Note, that all configured 
elements (agents, topics) deleted also. If a chat script is 
used in an active TaskFlow, then the chat script can not 
be deleted.  

Editing a Chat script 
You can edit the properties of a Chat script.  

Properties of a Chat script 
You can configure the following properties for a Chat script.  

 
Angaben Erläuterung 

Name Specifies the name of the Chat taskserver. You can use 
29 characters.  

Text  Specifies the text of the chat script.  

NOTE: The character % can not be used.  

Tag  You can use tags in the text. A tag is marked with a 
%.  
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Configuring the system settings 

General 
You can set the  general system settings.  

System language 
Shows the system language. You can choose a language for the user interface.  

Select a language from the list. The system language does not affect the language 
settings of individual users. 

The selected language setting is activated after the next log-in on the system. 
You can also change the language setting with the Agent Configuration dialog. 

You can select the following languages. 

• German 

• English 

Pause codes 
You can select whether you want to use pause codes. 

Call list 
The call list shows up to 100 different numbers. Once the maximum number is 
reached, the oldest entries in the list are deleted.  

Using the call list at the topic 

You can choose if a you want to use call lists for topics or not.  

Keep call list entries for 

You can set for how long the calls in the call list of a topic are to be saved. After 
the time set the IP Office Contact Center system deletes the call list entries. The 
setting is valid for all topics of the IP Office Contact Center system.  

You can set a value between one minute and 24 hours.  
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Time off 
The Definition of time off tab shows the defined time off periods with the 
following information.  

• Start 

• Stop 

• Repetition 

When do you use time off? 
You can use time off for the call distribution (task flow processing). You can use 
the time-specific keyword t.holiday in a logic of the Taskflow Editor 
application. The keyword t.holiday becomes 1 if a time off period is defined for 
the present time.  

What is the difference between breaks and 
blocked periods? 
Time off is, other than blocked periods, valid for the whole IP Office Contact 
Center system.  

Which actions can you execute with the 
Definition of time off tab? 
You can execute the following functions with the Definition of time off tab. 
There is a button for each action.  

Action Explanation 

Insert Creates a new time off period with the configured 
properties.  

Editing Opens the selected time off period. You can edit the 
properties 

Delete Deletes the selected time off 
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Which settings can you configure for time off 
periods? 
You configure the following properties for a time off period.  
Property Explanation 
Repetition 

 None 
 Daily (e.g. regular breaks) 
 Weekly 
 Yearly (e.g. national holidays) 

Specifies the repetition of time off periods.  
You can select whether a break is to be repeated 
daily, weekly, yearly, or not at all. 
An example of a daily repetition is the daily lunch 
break from 12:00 p.m. to 12:30 p.m. 

Start of time off You can set the date and time you want time off to 
start.  

If you set  Daily or  Weekly, you can only set 
the time.  
If you set  Weekly, you can select a day.  

You can enter the time or use  (up and down) to 
set the time.  

You can enter the date or click . A calendar in 
month view opens. A red circle  indicates 
today's date. A blue circle  indicates the set 
date.  

End of time off You can set the date and time you want the time off 
to stop.  
The settings are the same as for the start of the 
blocked period described above. The end of the 
time off must be after the start.  

 Ok 
 

Confirms your entries and closes the dialog.  

 Cancel 
 

Closes the dialog without applying the changes.  
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Reporting settings 
The Reporting Settings dialog shows the general settings for reporting. The task 
type-specific reporting settings are shown on individual tabs.  

Changes become effective starting from the next interval.  

General reporting settings 
General reporting settings are valid for all task types.  

Reporting method 

The reporting method shows which method is set for your IP Office Contact 
Center system. You can choose between interval-related and back office 
reporting in the IP Office Contact Center system.  

You can select the reporting method during the guided installation under 
Reporting type.  

Default: Interval-related reporting 

Interval-related reporting is used as default.  

Back office reporting 

You have to select Back office as the Reporting type during the guided 
installation if you want to use this method. 

For further information please refer to the documentation User Interface.  

Calculating period of time 

The calculated period of time shows the duration of a reporting interval in 
minutes. After each interval the value for the Task Service Factor (TSF) is reset 
to 100% and the calculation started anew. The Customer Service Factor (CSF) is 
also evaluated for the calculated period of time. 

You can set the following values for the calculated period of time: 1, 5, 15, or 30 
minutes. 

Reporting data is available in the following resolution 

A list shows the resolution of reporting data.  

The list shows the following information for reporting data. 

• Start time 

• Calculating period of time 
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Run compression 

Shows the settings for compressing reporting data.  

A database stores the reporting data. You can limit the storage requirement if 
you compress the data. However, the resolution of the reporting data is reduced 
when you compress the data. You can select after which period you want to 
compress the reporting data. 

Run compression  

You can select whether you want to compress the reporting data. The data of all 
task types is compressed.  

Smallest interval 

You can select the smallest interval.  

You can select one of the following settings. 

• 30 minutes 

• 60 minutes 

• 120 minutes 

Compress to smallest interval after x days 

The reporting data is compressed after the time set (x days). The data is 
calculated for the new resolution. The resolution of the data then matches the 
selected smallest interval. 

Compression to one day after y days 

The reporting data is compressed after the time set (y days). The data is 
calculated for the new resolution. The new resolution of the data is one day.  

The value for y must not be smaller than the value for x.  

Delete reporting data automatically 

You can have reporting data deleted after a certain period (days). Only the 
statistics data are deleted. For the task report data the period must be set 
seperatly. See topic: Task Report 

This period must be more than 90 days. You get a corresponding error message 
if you want to enter a shorter period.  

Default setting: 

 Delete reporting data automatically after 365 days 
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Reporting settings for the task type Telephony 
In the Telephony tab you find the reporting settings for the task type Telephony. 
You can set the reporting settings for topics, agent groups and agents.  

You can configure the following reporting settings (basic values) for topics. 

• Number of conversations 

• Number of unanswered calls 

• OD: Number of calls ended by external party 

You can configure the following reporting settings for agent groups. 

• Number of conversations 

• Number of unanswered calls 

You can configure the following reporting settings for agents. 

• Number of conversations 

• OD: Number of calls ended by external party 

Ring time threshold 
The ring time threshold defines when (duration of ringing) a call is counted as 
having exceeded the ring timeout. Enter the time in seconds. You can enter a 
minimum of 0 and a maximum of 240 seconds. 

totNExp1 stands for total of calls exceeding the ring time.  

Number of conversations 

totNConvWait stands for total conversations.  

TotNConvWait <= N 

A conversation call is counted if the wait time is shorter or equal to the set value.  

TotNConvWait > M 

A conversation is counted if the wait time is longer than the set value. The value 
must be greater than the value for TotNConvWait <= N. 

TotNConvWait > N <= M 

Shows the values of the first and second wait times.  

Number of unanswered calls 

totNAbanWait stands for total abandoned calls. 

TotNAbanWait <= N 

An abandoned call is counted if the wait time is shorter or equal to the set value.  

TotNAbanWait > M 

An abandoned call is counted if the wait time is longer than the set value. The 
value must be greater than the value for TotNAbanWait <= N. 

TotNAbanWait > N <= M 

Shows the values of the third and fourth wait times.  

OD: Number of calls ended by external party 

OD stands for Outbound Dialer.  

You can set a time in seconds for the counter. A call initiated by the Dialer 
counts as ended if the call was shorter than the time set.  
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Reporting settings for the task type Email 
The Email tab includes reporting settings for the task type Email. You can set 
the reporting settings (basic values) for topics, agent groups and agents.  

Number of emails 

totNDone stands for number of processed emails. The counter counts all emails 
processed by the agent.  

1. Wait time <= x 

The counter counts all mails that did not wait longer in the topic mailbox than a 
configurable time x. The minimal first wait time to be set is 0:30 h. 

2. Wait time > x h and <= y h 

Counts all emails that waited longer than a set time x and shorter than a set time 
y in the mailbox of the topic. The configurable maximum second wait time is 
168:00 h. 

What is wait time? 

Wait time is the configurable time when the counter totNDone starts counting.  
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Reporting settings for the task type Chat 
In the Chat tab you find the reporting settings for the task type Chat. You can set 
the reporting settings for topics, agent groups and agents.  

You can configure the following reporting settings (basic values) for topics. 

• Number of chat sessions 

• Number of unanswered chat requests 

You can configure the following reporting settings for agent groups. 

• Number of chat sessions 

• Number of unanswered chat requests 

You can configure the following reporting settings for agents. 

• Number of chat sessions 

Number of chat sessions 

totNConvWait stands for total chat sessions.  

TotNConvWait <= N 

A conversation call is counted if the wait time is shorter or equal to the set value.  

TotNConvWait > M 

A chat session is counted if the wait time is longer than the set value. The value 
must be greater than the value for TotNConvWait <= N. 

TotNConvWait > N <= M 

Shows the values of the first and second wait times.  

Number of unanswered calls 

totNAbanWait stands for total abandoned calls. 

TotNAbanWait <= N 

An abandoned chat request is counted if the wait time is shorter or equal to the 
set value.  

TotNAbanWait > M 

An abandoned chat request is counted if the wait time is longer than the set 
value. The value must be greater than the value for TotNAbanWait <= N. 

TotNAbanWait > N <= M 

Shows the values of the third and fourth wait times.  
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Deleting reporting data 
You can delete reporting data for a certain period if you need it no longer. Please 
note that once you have deleted the data it cannot be recovered.  

Format for the period 

Use the format DD.MM.YYYY for specifying the period. 

You can enter the date or click . A calendar in month view opens. A red circle 
 indicates today's date. A blue circle  indicates the set date.  

Prerequisites 
Privilege 

To delete reporting data, you must have the following privilege.  

• Delete data (Reporting tab) 

Set privileges for an agent.  

Recorded period 

You can only delete data within the recorded period of time.  

Deleting reporting data 
If you no longer need data for a certain period of time, you can delete it from the 
database. Use this feature e.g. for the data of a period you already analyzed 
thoroughly.  

Note 

Once data is deleted it is irretrievably lost. 

Delete 

To delete data, follow these steps.  

1. In the System menu, select Delete reporting data. The Delete 
Reporting Data dialog opens.  

2. Click  (down). A calendar opens.  

3. Select a date.  

4. Click OK.  

5. You are prompted.  

6. Click Yes to delete the data. The data is deleted. 



 

174  •  Configuring the system settings Using IP Office Contact Center  Configuration Tool 

Realtime information default values 
The Realtime information default values dialog shows the general settings for 
the Realtime information module. The task type-specific realtime information 
settings are shown on individual tabs.  

General realtime information default values 
Calculating period of time 

The calculated period of time shows the length of a realtime information interval 
in minutes. After an interval the value for the TSF is reset to 100% and the 
calculation starts anew. The DTSF (Dynamic Task Service Factor) is also 
evaluated for the calculated period of time. 

You can select one of the following values: 1, 5, 15, 30 and 60 minutes.  

Information: update interval 

Periodic realtime information is updated after the displayed time.  

Realtime information default values for the task 
type Telephony 
You can configure the wait time threshold for TSF and DTSF for topics and 
agent groups. You can also set the wait time threshold for the TSF for teams. 
These values are used a default values for the configuration. You can set the 
calculated period of time for TSF and DTSF. These values apply for the 
Realtime information module. 

Wait time threshold for TSF 

You can set the wait time threshold for the TSF. The wait time threshold can be 
set between 5 and 900 seconds (15 minutes).  

The wait time threshold determines the duration in seconds, after which an email 
is counted as having waited too long without being opened. Every call that has to 
wait in the queue for more than the duration set lowers the TSF. 

Wait time threshold for dynamic DTSF 

The wait time threshold determines the duration in seconds after which an email 
is counted as having waited too long without being opened. Every call that has to 
wait in the queue for more than the duration set lowers the DTSF. 
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Realtime information default values for the task 
type Email 
You can configure the wait time threshold for TSF and DTSF for topics and 
agent groups. You can also set the wait time threshold for the TSF for teams. 
These values are used a default values for the configuration. You can set the 
calculated period of time for TSF and DTSF. These values apply for the 
Realtime information module. 

Wait time threshold for TSF 

You can set the wait time threshold for the TSF. You can set the wait time 
threshold for TSF in hours and minutes (hh:mm).  

The wait time threshold determines the duration in hours and minutes, after 
which an email is counted as having waited too long without being opened. 
Every email that has to wait for more than the duration set reduces the TSF. 

Wait time threshold for dynamic DTSF 

Indicates the duration in hours and minutes, after which an email is counted as 
having waited too long without being opened. Every email that has to wait for 
more than the duration set reduces the DTSF. 
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Realtime information default values for the task 
type Chat 
You can configure the wait time threshold for TSF and DTSF for topics and 
agent groups. You can also set the wait time threshold for the TSF for teams. 
These values are used a default values for the configuration. You can set the 
calculated period of time for TSF and DTSF. These values apply for the 
Realtime information module. 

Wait time threshold for TSF 

You can set the wait time threshold for the TSF. You can set the wait time 
threshold for TSF in hours and minutes (hh:mm).  

The wait time threshold determines the duration in hours and minutes, after 
which a chat request is counted as having waited too long without being opened. 
Every chat request that has to wait for more than the duration set reduces the 
TSF. 

Wait time threshold for dynamic DTSF 

Indicates the duration in hours and minutes, after which a chat request is counted 
as having waited too long without being opened. Every chat request that has to 
wait for more than the duration set reduces the DTSF. 
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Variables 
You use variables with the Taskflow Editor. You have to configure variables 
before you can use them. You can access variables with the Realtime 
information module and change the configured values. 

You can define variables for the following objects. 

• <Global> 

• Agent 

• Agent group 

• Topic 

• VU script 

Which actions can you execute with the Defined 
Variables dialog? 
You can execute the following functions with the Defined Variables dialog. 
There is a button for each action.  

Action Explanation 

Insert Creates a new variable with the respective properties.  

Change Opens the selected variable. You can edit the properties 

Delete Deletes the selected variable.  

Inserting or changing variables 
You configure an object, a tag and a value for variables. The dialog shows the 
data type and if possible the resolution for each variable.  

Object 

Shows the object. You can select an object. If you select Global you can use the 
variable for all objects. 

Tag 

You can select a tag. The tag has to be configured. You can only use user-
defined tags for a variable. You configure tags with the System menu. 

Value 

Shows the value of the variable. You can change the value.  

Selecting a tag 
The Select Tag dialog shows the tags with name, type, data type and resolution. 
You can select a tag for the variable.  
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Tag list 
The Defined Tags dialog shows the defined task tags. It makes no difference 
whether a tag is system-specific, user-defined or a skill.  

The following information is listed.  

Setting Explanation 

Name Shows the name of the tag.  

Type Shows the data type of the task tag (user, system, skill). 

Data type Shows the data type of the task tag (string or number).  

Resolution Shows the resolution of the task tag (whole numbers 
only). 

What is a tag? 
A tag can be added to a task. You can evaluate tags in a task flow set. 

Which actions can you execute with the Defined 
Tags dialog? 
You can execute the following actions with the Defined Tags dialog. There is a 
button for each action.  

Action Explanation 

Insert Creates a new tag with the respective properties.  

Change Opens the selected tag. You can edit the properties 

Delete Deletes the selected tag. You cannot delete system-
specific tags.  
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Inserting or changing tags 
You configure name, type, data type and perhaps resolution for a tag.  

Name 

Shows the name of the tag. You can use 29 alphanumeric characters maximum. 

Type 

Shows the type of the tag. You can make a tag accessible for yourself only (user-
defined), for the whole system (system-specific) or define it as skill.  

Data type 

Shows the data type of the tag. You can choose String, Number, Time in GMT 
or Duration in seconds. 

Resolution 

If you select integer as the data type, you can determine the resolution. The 
following settings can be chosen. 

Integer e.g. 42 
tenth  e.g. 46.1 
hundredth E.g. 46.14 

Can be changed by CGI server 

You can set whether the CGI server may change a tag or not.  

Please note that if a task Tag is modifiable unauthorized persons might be able to 
change the tag as well.  

Overwrite-protection 

You can determine whether a task tag is overwrite-protected.  

Applying Tags into Task resulting from 
Conference/Transfer  
Explanation 
Whether to apply tags from initial call (C1) or from consultation (C2) into the 
resulting call depends on the meaning of the tag and on customer. You can 
define how it will be handled in the configuration of each tag. 

When transferring, a new connection (C3) is established after consultation.  

No new connection is established after conference. The resulting connection is 
the original call (C1).  

Tags from the original connections are always applied to the new connections. 
Tags from conferences are ignored by default.  

Tag coming from a conference can be applied when configured accordingly. You 
can configure for a conference tag to always apply into the resulting connection. 
Is the same tag available in the original connection, its value will be overwritten 
(C1 value is preserved).  

Task: E-Mail 
Delegating e-mails behaves like call transfer. Therefore the same rules apply for 
delegating.  
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Possible options 
With the following options you can specify what happens with a tag when a call 
is transferred, a conference initiated or an e-mail delegated. 

• Ignore 
The tag from a consultation is not applied to the resulting task.  

• Apply, where applicable overwrite 
The tag will be applied and overwritten where applicable.  

• Apply only if transferred, where applicable overwrite 
The tag will be applied only if transferred and overwritten where 
applicable.  

• Only applied if not available in the original task 
The tag will be applied only when not available in the original task 
(call).  

Examples 
Examples for a useful tag configuration in case of transfer or consultation:  

Task Option 

LastTopicName apply, where applicable overwrite 
FirstTopicName apply only if not available in the original task  

Which tags are prepared in the IP Office Contact 
Center system? 
For information on the prepared tags <system>, see TaskTags manual.  
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Configuration report 
You can export the current configuration data into Microsoft Excel sheets.  

All exported configuration data is displayed in tabular form. You can edit, save 
and print this data. 

What do you need for a configuration report? 
You need Microsoft Excel version 5.0 or higher. The software must be installed 
on your PC. 

How long does the export take? 
Please note that depending on the volume of your data the export may take a few 
minutes. 

Which configuration data can you export? 
You can convert the following configuration data. 

Topics 

• General 

• Blocked periods per topic 

• Announcements per topic 

• Skills per topic 

Agent groups 

• General 

• Agents per AG 

• Virtual AGs 

Agents 

• General 

• Topic authorization 

• AG authorization 

• Agent authorization 

• Team authorization 

• Telephone authorization 

• Telephone group authorization 

• Campaign authorization 

• Privileges 

• Skills per agent 
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Profiles 

• General 

• Topic authorization 

• AG authorization 

• Agent authorization 

• Team authorization 

• Telephone authorization 

• Telephone group authorization 

• Campaign authorization 

• Privileges 

Others 

• Team composition 

• Announcements 

• Announcement scripts 

• Voice unit 

• VU scripts 

• Shift plan 

• Queue device 

• Defined tags 

• Variables 

• External destinations 

• Customer recognition 

• PBXs 

• Country setting 

• Task server/CHAP 

• System 

• External display 

• Wallboards 

• Job codes 

• Reporting filters 

• Telephone 

• External line 

• Chat server 

• Chat scripts 
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Availability for tasks 
The Availability for Tasks dialog shows for each task type, which conditions 
must be met for the agent not to receive additional tasks.  

You determine these settings with the default settings.  

Task type Telephony 
You can configure the following settings for the task type Telephony. 

How many calls maximum does the agent get? 

You can either select 0 or 1 as maximum number of calls.  

Does the agent get emails while they get a call or are on the telephone? 

You can select Yes or No.  

Setting Explanation 

Yes If it rings or the agent holds a conversation, then the agent can receive 
further emails.  

No If it rings or the agent holds a conversation, then the agent does not 
receive further emails.  

Does the agent get chat requests while they get a call or are on the telephone? 

You can select Yes or No.  

Setting Explanation 

Yes If it rings or the agent holds a conversation, then the agent can receive 
further chat requests.  

No If it rings or the agent holds a conversation, then the agent does not 
receive further chat requests.  

Task type Email 
You can configure the following settings for the task type Email. 

How many emails maximum does the agent get? 

You can select or enter a value between 0 and 100 for the maximum number of 
emails.  

Does the agent get calls while they process an email? 

You can select Yes or No.  

Setting Explanation 

Yes If the agent process an email (email is opened), then the agent can 
receive calls.  

No If the agent process an email (email is opened), then the agent 
does not receive calls. 

Special feature 
As default for the setting No, the agent receives no calls when opening an e-mail.  

You can change this setting. The agent receives no calls when e-mails are 
available in his inbox. 

• You must create a global variable 
g.CCK_AlertingEMailBlockCond.  

• Variable type must be integer. 
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• Variable value must be 1.  

This setting will be immediately effective in the server components and applies 
with the next change of the agent state.  

Does the agent get chat requests while they process an email? 

You can select Yes or No.  

Setting Explanation 

Yes If the agent process an email (email is opened), then the agent can 
receive chat requests.  

No If the agent process an email (email is opened), then the agent 
does not receive chat requests. 

Task type Chat 
You can configure the following settings for the task type Chat. 

How many chat requests maximum does the agent get? 

You can select or enter a value between 0 and 100 for the maximum number of 
chat requests.  

Does the agent get a call while they process a chat request? 

You can select Yes or No.  

Setting Explanation 

Yes If  the agent process a chat request, then the agent can receive further 
calls.  

No If the agent process a chat request, then the agent does not receive 
further calls.  

Does the agent get emails while they process a chat request? 

You can select Yes or No.  

Setting Explanation 

Yes If  the agent process a chat request, then the agent can receive further 
emails. 

No If the agent process a chat request, then the agent does not receive 
further calls. 
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Skill overview 
The Skill Overview dialog shows tabs with the following skills. 

• Agent skills 

• Topic skills 

Skills must be configured in the tag list. 

See: Configuring tags (skills) 

List box: View 
A drop-down list-box shows the objects configured specifically for skills. You 
can select different objects. 

The respective objects are displayed for the following task types.  

Task type Object 

<All> Shows all objects. 

Telephony Show the skills and skill levels for Telephony.  

Email Show the skills and skill levels for Email.  

Tab: Agent skills 
You can enter agents' knowledge and capabilities with the Agent skills tab. 
Agents and configured skills are listed in a table. You have to enter a skill level 
for a skill. 100 is the maximum setting. The value shows the skill level in 
percent. You thus specify the agent's minimum requirement.  

Proceed as follows to enter new values. 

1. Edit a field and enter a value. Newly entered settings are in red 
writing.  

2. Click Apply. The settings are applied and the writing changes to 
black. 

The following table shows an agent skill example. 

Agent skills    

 A_speaks_German A_speaks_English A_speaks_Spanish 

A001 100 80 - 

A002 100 - 50 

A003 50 100 - 

A004 50 20 50 

A005 20 100 100 
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Tab: Topic skills 
You can enter agents' knowledge and capabilities regarding topics with the 
Topic skills tab. Topics and configured skills are listed in a table. You have to 
enter a skill level for a skill. 100 is the maximum setting. The value shows the 
skill level in percent. You thus specify the agent's minimum requirement for 
topics.  

Proceed as follows to enter new values. 

1. Edit a field and enter a value. Newly entered settings are in red 
writing.  

2. Click Apply. The settings are applied and the writing changes to 
black. 

The following table shows a topic skill example. 

Topic skills    

 Knows_product_A Knows_product_B A_speaks_German 

 
  

 
  

 
  

 

Topic 001 50 50 

 

- - 

 

90 80 

 

Topic 002 90 - 

 

80 - 

 

90 80 

 

Topic 003 90 90 

 

50 50 

 

90 80 

 

Topic 004 - - 

 

50 - 

 

90 80 

 

Topic 005 80 - 

 

30 - 

 

90 80 
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Interface for staff planning 
The reporting data of a IP Office Contact Center system is stored in the internal 
tables of the IP Office Contact Center system Sybase database in a complex 
structure. To offer external modules (INVISION) easy access to reporting data, it 
is possible to provide edited data referring to topics via an ODBC interface on a 
daily basis.  

Prerequisites for using the interface for staff 
planning 
The following prerequisites must be met if you want to use the interface for staff 
planning.  

• The XSTAT server must be installed and configured at the IP 
Office Contact Center system server. The xstat_srv process must be 
running.  

• A Sybase ODBC driver must be installed and configured for the 
external module.  

Time settings 
You configure start time, duration and interval for the surveyed period (daily). 

The following table shows the settings and provides explanations.  

Setting Explanation 

Start time Shows the start time for the reporting survey. Use the format 
hh:mm (hours, minutes).  

Duration Shows the duration of the reporting survey. Use the format 
hh:mm (hours, minutes).  

Interval Shows the reporting interval for the reporting survey. You 
have to enter either the calculated period of time for the 
reporting settings or a multiple of this value. Use the format 
hh:mm (hours, minutes).  

Start calculation Shows the start of the calculation. You usually start the 
calculation at a low-load time, e.g. at night. Use the format 
hh:mm (hours:minutes).  

Keep data for Shows for how long the data is kept in the IP Office Contact 
Center system database (Xstat table). The data is overwritten 
after this period.  

 

Counters 
There are three tabs (Topic counters, Agent group counters an Agent counters) 
with which to select counters. Each of these three tabs features a lost of counters. 

A list shows the counters for the staff planning interface. The list shows only 
counters for topics with the task type telephony. You can select counters.  



 

188  •  Configuring the system settings Using IP Office Contact Center  Configuration Tool 

Task report 
You can start or stop task reports.  

Prerequisite 
To start or stop task reports, you must have the following privilege.  

• Start/stop reports (Other tab) 

View option 
A list shows the task reports with the following settings.  

Name 
Shows the name of the task report. 

The following task reports are created by default.  

• LevelOne 

• LevelTwoAgent 

• LevelTwoTopic 

• AgentLogging 

Status 

Shows the status: active or inactive.  

Starting or stopping 
To start or stop a task report, follow these steps.  

1. Under System, select Task report. The Task Report dialog 
opens.  

2. Select a task report.  

3. Depending on the state, you can either start or stop the task report.  

Deleting data 
You can configure the time period for automatic deletion of task report data.  

Time period 
You can set the time period to 90 days minimum and 24855 days maximum. 

Note 
Restart the process tr_srv to use changes.  

Configure 
Proceed as follows.  

1. Select Task Reports in the System menu. The dialog Task 
Reports opens.  

2. Select Automatic deletion of task report data. 

3. Enter a time period in days.  

4. Click on OK to save your settings.  
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Shift plan 
The shift plan is used for the following online realtime information. The online 
realtime information is reset (to zero) at the start of each new shift.  

1. Topic realtime information: Number of conversations per shift 
(Telephony) 

2. Topic realtime information: Total of all calls transferred to external 
destinations per shift (Telephony) 

3. Agent realtime information: Number of conversations per shift 
(Telephony) 

Shifts 
You can include any number of shifts in the shift plan. You either treat the shifts 
alike for all weekdays or you can set the respective shifts for each individual 
weekday.  

If you want to configure shifts for each weekday you have to remove the 
checkmark for all days identical.  

You can add or delete shifts or delete all shifts.  

You can only set the start time for a shift. Each start resets the respective 
realtime information.  
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Configuring the service settings 

Overview of service settings 
You learn about the possible service settings and how you configure these 
settings.   

Prerequisite 
You need the corresponding special privilege to change the service settings.  

List of service settings 
You can change the following service settings if you are signed on as a user with 
permission to change these settings.  

• Reporting filters 

• Special settings 

• Telephone default settings 

• Announcement modules 

• PBX 

• Country settings 

• Queue device 

• Telephone 

• CHAP server 

• Access code agents 

• Access code topics 

• Email settings 
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Reporting filters 
The Reporting filters dialog lets you configure system-wide which reporting 
data can be evaluated in the IP Office Contact Center system. You can e.g. 
exclude data from being evaluated for labor legislation reasons.  

There are individual counters for each task type. The tabs show the counters for 
the different task types.  

Prerequisite 
To set reporting filters, you must be signed on as a user with permission to do so.  

Which types are there? 
You can select the following types. The corresponding counters are displayed. 

• Shows the name of the task report. 

• Agent group 

• Dialer 

• Line 

• Skill combination 

• System 

• Team 

• Telephone 

• Topic 

• PBXs 

• Voice unit 

List of counters 
A list shows the counters of the respective type. The counters of a type are 
subdivided into topics.  

A + (plus) shows that there are further counters for this topic. Click the plus to 
have all counters of this topic displayed. You can also click a topic to change the 
structure. 

Selecting the view 
You can choose whether the abbreviations or names of counters are to be 
displayed for the type of reporting filter. Select an option. 

If name is selected the special characters * and # mean the following. An asterisk 
(*) signals that in the evaluation the counter is broken down into agent groups. A 
hash (#) signals that the counter is broken down into topics. 

Where can you get additional information on 
counters? 
For further information on reporting counters please refer to the documentation 
of the statistics counters.  
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Modifying the reporting counter name  
You can modify the name of a reporting counter. The system name will always 
be added in brackets to the new name. The modified name will be used in all 
reporting displays and evaluations. Please notice that the headers of reporting 
evaluations become multi line for long counter names. In the headers, a line 
break occurs after 40 characters.  

Modify 
Proceed as follows to modify the name.  

1. Double-click the reporting counter. The dialog Modify Counter 
Name opens.  

2. Enter the new name. The name can be 255 characters long.  

3. Click on OK to save your settings.  

Reset 
To reset the modified name to the system name proceed as follows.  

1. Double-click the reporting counter. The dialog Reset Counter 
Name opens.  

2. Click on Delete. The system name is now assigned to the counter.  
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Special settings 
You can configure the following special settings.  

• Allow changing topic names 

• Allow changing agent group names 

• Minimum team size 

• Reporting from caller's point of view 

• Reporting type 

• Reporting/Realtime information 

• Last/Current agent routing function 

Prerequisite 
To set special settings, you must be signed on as a user with permission to do so.  

Allow changing topic names and Allow changing 
agent group names 
If the two boxes are checked an agent with normal privileges can change the 
names of topics and agent groups. This is the default. You determine the usual 
privileges with the Agent privileges. 

If the two boxes are not checked only service personnel with the necessary 
password can change the names.  

Minimum team size 
You can configure how many agents have to be members of a team. This number 
is checked if a team is configured.  

You can set between 0 and 1000 members as minimum size.  

Reporting from caller's point of view 
You can select whether connections with external destinations are to be counted 
as successful.  
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Reporting type 
You can select a reporting type as an option. 

Setting Explanation 

Interval reporting The Interval reporting option lets you save conversation 
times, call times and other times in their respective 
intervals. 

Back office reporting The Back office reporting option stores all counters in the 
intervals in which the call entered the system. 

For more detailed information, see the IP Office Contact 
Center user manual. 

Note: If you change the reporting type, you can no longer 
evaluate old data. You must restart the PC for the change 
to take effect. 

Reporting/Realtime information 
Time slot for redialing 
You can enter between 5 minutes and 12:00 hours for the time slot for redialing.  

Callers who call again in the time span after a first call does not go through are 
counted as redialers.  

Time slot for First Call Resolution 

First Call Resolution (FCR) numbers the portion of the requests, which are 
finished with the first call. If a caller in the time slot does not call again, then the 
call is considered as finished.  

For the time slot you can enter a value between 1 hour and 7 days. Default is 3 
days.  

If the IP Office Contact Center server is started, then the time slot starts. 
Previous calls are not considered for the statistics.   

Last/Current agent routing function 
You can select the Last and current agent routing function as an option.  

 

Setting Explanation 

System-wide The System-wide option saves the caller number and 
connected agent to a topic following a conversation. If 
the caller calls again in the defined period, he is 
reconnected to the same agent, even if the topic is 
different. 

Topic-specific The Topic-specific option connects the caller to the same 
agent only if he selects the same topic. 

 

Additionally send as an Email 
If you want to send automatic statistics as an Email, you must specify an SMTP 
server. An Email contains the automatic statistics  an attachment.  
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1. Configure the SMTP server name under Service > Special Settings. 
For example: mailserver.com 

2. Configure the output email message format in the database. 

a. Check the Additionally send as email check box. 

b. Enter an email address. 

c. Enter a subject. 
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Telephone default settings 
You can configure default settings for telephony.  

Prerequisite 
To set telephone default settings, you must be signed on as a user with 
permission to do so.  

Telephone settings 
You can make the following telephone settings.  

 

Setting Explanation 

Automatic answer 

 for incoming ACD calls 

 for outgoing ACD calls 
(dialers) 

after x s 

You can enable or disable automatic answer. 
A call is answered automatically after the 
specified time. The agent does not have to 
click the Answer key. You can set a time 
between 0 and 255 seconds. 
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Inserting or changing an announcement module 
You can insert a new announcement module or edit a configured announcement 
module. 

Pseudo number 

Shows the pseudo number of the announcement module. 

Name 

Shows the name of the announcement module. You can use 30 alphanumeric 
characters maximum.  
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Access code agents and Access code topics 
The Access code agents and Access code topics dialogs show the external line 
code, extension length and PBX.  

Prerequisite 
To configure settings for access code agents and access code topics, you must 
be signed on as a user with permission to do so.  

Which actions can you execute with the Access 
code agents dialog? 
You can execute the following actions with the Access Code Agents and Access 
Code Topics dialogs. There is a button for each action.  

Action Explanation 

Change Opens the Access Code - Edit dialog. You can edit the 
properties. 

Insert Opens the Access Code - Create dialog. You can edit 
the properties. 

Delete Deletes the selected external line code.  

Editing an external line code 
You can edit the following properties. 

PBX 

Shows the name of the PBX. 

Access code 

Shows the external line code of the PBX, 4 digits maximum. 

Digits for extension 

Shows the length of the extension number. The length of external line code plus 
extension is limited to 9 digits. You can enter a minimum length of 0 (zero).  
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Email settings 
The Email settings dialog lets you define the system settings for UMR domains 
and the prefix and postfix for the ticket IDs.  

Prerequisite 
To define email settings, you must be signed on as a user with permission to do 
so.  

System settings tab 
You must enter the following settings on the Email settings tab. You need these 
settings if you are using UMR in the IP Office Contact Center system.  

 

System setting Explanation 

UMR Domain Enter the agent and topic domain.  

Note: In the Email configuration module, you must also 
configure this UMR domain under Local accepted DNS 
domains. 

Example: company.com 

Prefix for ticket ID You can enter a prefix for a ticket ID. If you enter a 
prefix, this prefix is displayed in front of the ticket ID in 
the subject line of email replies or forwards. 

Postfix for ticket ID You can enter a postfix for a ticket ID. If you enter a 
postfix, this postfix is displayed after the ticket ID in the 
subject line of email replies or forwards. 

Chat settings 
You can use an archive database for chat.  

Prerequisite 
A chat archive database has to be installed.  

Archive settings 
Activate archive 

You can activate the archive for chat requests.  

Start time for deletion 

Specifies the hours and minutes after midnight when the deletion starts. The 
deletion starts every day.  

Standard: 2:30 hours 

Delete archive data automatically 

Displays the time chat requests are stored in the archive database. Older chat 
requests are deleted from the archive database.  

The period is set for the TR report.  
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Using the Help and About 
dialogs 

Using the Help 
The Configuration module offers a dialog-oriented, context-sensitive Help 
function for all menus, commands and dialogs. You can search for information 
on a certain topic. 

Help during the operation 
You can open Help information for each command and dialog. 

1. A dialog is open. Press the F1 key. The Online help for this dialog 
opens. 

Starting the Online Help 
You want to read the contents of the Online Help. 

1. Select Contents from the Help menu The Online help opens. 

2. Click a text to obtain further information about the topic. 
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Displaying information about the Configuration 
module 

You can have information displayed about the manufacturer and the program 
version. 

Information in the About Configuration dialog 
The About Configuration dialog provides the following information. 

Name 

Shows the icon, name and release of the Configuration module. 

Copyright 

This information shows the copyright. 

Other ways to get help 
You can get additional support on the Internet. 

Information on the Internet 
Please refer to the following Internet site for information on IP Office Contact 
Center systems.  

www.avaya.com 
 

http://www.avaya.com/�
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Glossary 

ACW 
ACW stands for After Call Work.  

AES 
The AES server is a media server. This media server establishes the TSAPI 
connection between the IP Office Contact Center system and PBX.  

CSV 
CSV stands for separated values or comma separated values. A CSV file is a text 
file for saving or exchanging data with a simple structure.  

Fax 
Fax is short for facsimile or telefacsimile.  

NC 
NC stands for network computer. Network computers are terminals adapted to 
the Internet. Since NCs have their own local CPU power, they are referred to as 
network computers instead of network terminals. NCs are computers that do not 
have a hard disk and download their software from the network.  

RPC 
RPC stands for Remote Procedure Call. An RPC is the call of a procedure in a 
module or task that might be located on a remote PC. Strictly speaking, a 
procedure is called on the local host and run on the remote host. Possible results 
and the end of the procedure are returned to the first PC (local host).  

SMS 
SMS stands for Short Message Service and is a telecommunications service for 
transferring text messages.  

TSF 
TSF stands for Task Service Factor.  
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UNC 
UNC stands for Uniform Naming Convention. UNC is a widely accepted 
standard for addressing shared resources (folders, drives and the like) on a PC 
network. It eliminates the need to assign a drive letter to connect. Example: 
\\servername\sharename\path (Windows).  

VEA 
VEA stands for Voice Extension Adapter.  
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